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Box Contents

Navman PiN 570

q PiN Carry Case

| PIiN Suction-Mount Arm

‘ PN PDA Cradle

%— AC Power-Pack

with Power-Cable

SD/MMC Card*

*Not included with PiN

purchased in United States.
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SmartST Application Installer CD

including:

. SmartST 2005 software,
including SmartST Desktop

. User Manual (PDF format)
and Adobe® Reader®

. Map data

One or more SmartST Map CDs
Note: The number of disks varies
with country of purchase.

PiIN Companion CD, including:
o Microsoft® ActiveSync®
. Outlook 2002

12V In-Vehicle Power
Adaptor with Power-Cable

B PRI /3B Cable

Documentation, including:
. PIN 570 Pocket PC

User Manual

. SmartST for Pocket PC
User Manual

. In-Car Installation Guide

. Software Product Licence/
Limited Warranty Agreement
. Registration Card
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1. Introduction

Thank you for purchasing the Navman PiN 570. Whether you travel in your own country or
elsewhere, the PiN will direct you to your destination without the need for map-books and second-
hand instructions.

The Global Positioning System (GPS) is available free of charge, at any time, and is accurate to
within 5 m (15 ft). Your PiN map provides street-level detail for door-to-door navigation, including
Points of Interest (POls) such as accommodation, petrol stations, railway stations and airports.

Use this manual to learn how to operate your PiN efficiently and safely, and discover all the
different features available to you.

For details about GPS and your PiN, see GPS and GPS Signals, page 74.

Safety Notice

WARNING: In a vehicle, it is your sole responsibility to place, secure and use the PIN in a
manner that will not cause accidents, personal injury or property damage. The user of this
product is solely responsible for observing safe driving practices. It is your responsibility to read
and follow the vehicle mount installation instructions and to use the product consistent with your
government’s laws/regulations. Consult the vehicle manual to ensure the mounting location is
safe.

It is your sole responsibility to adhere to the following safety instructions at all times:

e Do not operate the PiN while driving or place the PIN in a position that obstructs the
driver’s view.

e Do not mount the PiN in a way that may be distracting or interfere with the safe
operation of the vehicle, the deployment of airbags or other safety equipment.

e Do not leave the PiN in view while your vehicle is unattended, especially in strong or direct
sunlight.

e Do not use or handle the PiN when it is hot; leave it to cool, out of direct sunlight.

Failure to adhere to these instructions may lead to serious personal injury, including death, or
property damage. Navman disclaims all liability for use of the PiN that contributes to injuries,
death, property damage or violates law.
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2. PIN Features

Your PiN 570 is designed to be easy to use. This chapter highlights the external features of your

PiN:

Front Components

Component

Description

© | Charge Indicator

Flashing Green — Indicates the battery is charging.

Solid Green — Indicates the battery is fully charged and the unit is receiving
external power.

Flashing Red — Indicates low battery.

@® | Notification Indicator

Flashing Amber — Indicates the GPS receiver is turned on and is trying to
establish a GPS fix.
Solid Amber — Indicates the GPS receiver is turned on and has a GPS fix.

© | Touch Screen

Displays maps and menu options. Tap with the stylus to select menu options
or enter information.

@ | Program Buttons

The four buttons provide quick access to specific programs.
The default settings are:

()
. Navigate (using SmartST)
e / Calendar
e - Contacts

o
. Today screen

Each button may be customized. Tap &4 - Settings = Buttons icon. In the
left column of the table, tap the button you want to customize, then choose
the button assignment from the Button assignment: drop-down box.

© | 4-Way Toggle

Moves up, down, left or right. Depending on the program that is open, the
toggle may move the cursor or scroll the screen.

In SmartST, selects Main Menu options and scrolls through lists, such as lists
of search results. Press up or down to adjust the viewing angle on the 3D
Map screen. Zoom in and Zoom out on the 2D and 3D Map screens.
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Back Components

(1
(2]
1) NAVMAN
Pocket PC
©
Component Description
@ | GPS Receiver Receives signals from the GPS satellites overhead when lifted up to
the horizontal position.
@ | External Antenna Connection socket for GPS external antenna (sold separately).
Socket Protected by rubber cover.
© | Speaker Qutputs voice commands and warnings. Use the Up/Down Toggle
to adjust volume.
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Left-Side Components

Component

Description

(1) Power Button

Turns your Pocket PC on or off by pressing briefly.
Turns the screen backlight on or off by pressing and holding.

(2] Up/Down Toggle

Rotate up or down to scroll through menus. Press to select
an option.

Note: In SmartST, this is a zoom in/out toggle.




PiN 570 | User Manual

Top Components o L2
(4]
©
Component Description
@ | Microphone Records messages.
@ | SD/MMC Slot Slot for SD (Secure Digital) or MMC (Multimedia Card) memory card -
must be inserted with label facing front.
3] Stylus (in slot; not Tap the stylus on the touch screen to select and enter information.
shown) Store it in its slot when not in use.
@ | Headphone Socket | Connection socket for headphones (sold separately).

Bottom Components

Component

Description

(1] Soft Reset

Resets the PiN. Press using the stylus.

@ |USB/Power Socket

Connection socket for USB cable and for power supply to recharge
your PiN.

© | Hard Reset Switch

Resets the PiN and restores all factory default settings. Move the
switch to the left, then back to the right using the stylus.

WARNING: A hard reset will restore default settings, deleting all
custom-loaded software, files and customized settings stored on
internal memory.
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Stylus

‘-)

The stylus is your input PiN. Store it in its slot when not in use.
e Tap the screen with the stylus to select

e Tap and drag the screen with the stylus to navigate the 2D Map and 3D Map screens.
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3. Battery

When fully charged, your PiN will operate for a varying length of time, depending on two main factors:
(1) Whether the GPS receiver is turned on; (2) whether the backlight is set to on the default or high setting.

Expected
Battery-Life
PiN Features Setup (hours)
Default backlight without GPS 10.3-11.0
Default backlight with GPS 2.5-3.0
High backlight without GPS 4.0
High backlight with GPS 1.75

To change the GPS status, see GPS and GPS Signals, page 74.

To change the backlight settings, tap -> Settings—> System tab > Backlight.
The Backlight screen will open, allowing you to change backlight setting to save power.

Backlight

Warning: Using backlight while on battery
pawer will substantially reduce battery Ife.

On battery power:

Turn ofF backlight if

device is not used For

Turn an backlight when a button is
pressed or the screen is tapped

Super MNormal Power Backlight
Eright. Eright Save OFf
! : . !
I
LF

Battery Power | External Power

Adjust power settings to conserve power,

E|A




Battery Power Status
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You can monitor battery power at the Power screen by tapping -> Settings > System tab > Power.

Fid - T T
i, ¢
/73 |settings o g os0 @

Power

Main hattery:

Turn off device if not

used For

On external power:

O Turn off device if not

used for

Main battery: Lilon
Recharging state: Charging
o e R

Adjust backlight settings to conserve power .
=8

Charging the Battery

We strongly recommend that you fully charge your PiN before initial use.

When the battery is charging, the Charge Indicator is flashing green. When the battery is fully
charged and receiving external power, the Charge Indicator is non-flashing green. You may use

the PiN while it is charging.

Whenever possible, keep your PiN connected to a power source; doing so keeps the battery

charged.
To charge the PiN... Plug the...
in a vehicle Vehicle power-adaptor into the USB/Power Socket on the bottom of

the PIN and the other end into the vehicle power socket.

using a power supply

ActiveSync cable into the USB/Power Socket on the bottom of the
PiN. Connect the power adaptor to the appropriate end of the Active
Sync cable and the other end into a wall outlet.
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4. GPS and GPS Signals

GPS stands for “Global Positioning System”, which is a network of satellites that transmit accurate time and
position information worldwide. GPS receivers receive signals from these satellites and use the information to
determine an exact location. Satellites orbit the earth at approximately 20,200 km (12,000 miles). While a GPS
receiver can detect signals from up to 12 satellites at any time, only three signals are needed to provide a
position or “GPS fix” (latitude and longitude) for vehicle navigation systems.

The PiN GPS antenna receives GPS signals. To receive GPS signals, ensure that the PiN is outdoors, or in a
vehicle outdoors, and the GPS antenna has an unobstructed view of the sky. The PiN can operate in all
weather conditions except when it is snowing.

NOTE: When you start SmartST, the GPS receiver will automatically turn on.

To manually turn the GPS on or off:

Tap i - Settings—> System tab - GPS.
Tap ON or OFF.
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5. Microsoft ActiveSync

Using Microsoft ActiveSync, you can synchronize the information on your computer with the
information on your PiN. Synchronization compares the data on your PiN with your computer
and updates both computers with the most recent information.

NOTE: By default, ActiveSync does not automatically synchronize all types of information. Use
ActiveSync options to turn synchronization on and off for specific information types.

Use ActiveSync to:

Keep Pocket Outlook data up-to-date by synchronizing your PiN with Microsoft Outlook
data on your computer.

Synchronize Microsoft Word and Microsoft Excel files between your PiN and computer.
Your files are automatically converted to the correct format

With ActiveSync, you can also:

Back up and restore your PiN data.
Copy (rather than synchronize) files between your PiN and computer.

Control when synchronization occurs by selecting a synchronization mode. For example,
you can synchronize continually while connected to your computer or only when you
choose the synchronize command.

Select which information types are synchronized and control how much data is
synchronized. For example, you can choose how many weeks of past appointments you
want synchronized.

Before you begin synchronization, install ActiveSync on your computer from the PiN 570
Companion CD. ActiveSync comes preinstalled on your PiN.

WARNING

Do not connect your PiN to your computer unless you have Microsoft ActiveSync
installed or until prompted to do so during the installation process.
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Installing ActiveSync on Your Computer

1. Turn on your computer and allow Microsoft Windows to start.

2. Insert the PiN Companion CD into the CD drive of your computer.
The Getting Started with your Pocket PC window will open.

3. Click Getting Started With Windows Mobile or wait for the Getting Started With Your
Windows Mobile™ based Pocket PC screen to appear.

4.  Click Start Here.
The Start Here screen will display.

5. Click Install ActiveSync in the left-hand column.
The Install Microsoft® ActiveSync® screen will display.

6. Click Install and follow the on-screen prompts to install Microsoft ActiveSync.

7. When prompted, connect your PiN to your computer:
. Connect the appropriate end of the ActiveSync cable to the bottom of your PiN.
e  Connect the USB end of the cable to a USB port on your computer.

8. The Add New Hardware Wizard should automatically install the USB driver. (If you need to
specify the location of the driver, click Browse and select the CD drive containing the PiN
Companion CD.)

9.  Follow the on-screen prompts to establish a partnership and synchronize your PiN with
your computer.

After your first synchronization, the data you have stored on your computer such as Calendar,
Contacts and Tasks is copied to your PiN.

For information on adding or removing programs using ActiveSync, see pages 39-40.
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6. Memory Card

Your PiN may come with a memory card containing a preactivated SmartST map of the region in
which it was purchased. To navigate to your destination you will first need to insert the memory
card into your PiN.

Note: If your PiN did not come with a memory card, or if you are using a memory card other than
the one that came with your PiN: To use SmartST, you must purchase a memory card
separately. Then, you may install the required maps from the enclosed Map CDs using SmartST
Desktop.

For more information, see the SmartST 2005 for Pocket PC User Manual.

WARNING: Before connecting your PiN to your computer, make sure that ActiveSync is installed
on your computer.

Inserting Memory Card

Gently insert the memory card into the SD/MMC slot with the label facing the front of the PiN.

NYWAYN

NAVMAN

Removing Memory Card

Gently push down on the top edge of the card to release it, and pull it out of the slot.
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/. Starting Your PiN

1. Check the Hard Reset switch on the bottom of the PIN. If this is in the left position, remove
the stylus and use it to set it to the right and set up your PiN for use.

OFF ——> ON

2. Press the Power button @ on the left side of the PIN

The PiN will turn on. The first time you use your PiN, you will be prompted to set up your
Pocket PC.
On subsequent occasions, the Today screen will display.

3. Gently pull the bottom of the GPS receiver away from the PiN and lift it out to a horizontal
position so that it can obtain a GPS fix.

Starting SmartST

Whether you travel in your own country or elsewhere, SmartST will direct you to your
destination without the need for map books and second-hand instructions. The Global
Positioning System (GPS) is available free of charge, at any time, and is accurate to within 5 m
(15 ft). Your Smart map provides street-level detail for door-to-door navigation, including Points
Of Interest (POls) such as accommodation, railway stations and airports.

1. To open SmartST, press the SmartST button ” on the front of the PiN.

2. The Language Selection screen will display on PiN 570s purchased outside of Australia,
Canada, New Zealand or United States, the first time you open SmartST.
e  Tap the language name or associated flag icon, then tap &.

3. The Legal Notice screen will display. Read the legal notice and tap | Agree to confirm you
understand.

4. The Tutorial will display. Tap @ to move through the screens.
The 2D Map screen will open.

For more information about SmartST, see the SmartST 2005 for Pocket PC User Manual.



8. Positioning the PIN in a Vehicle

Before you begin, determine whether your vehicle is fitted with a heat-reflecting or heated
windscreen. If so, you will need to purchase an external antenna for your PiN to receive GPS
signals.

Read the Safety Notice on page 6 to ensure that the PiN does not obstruct the driver’s view, or
interfere with the operation of vehicle airbags and safety devices.

Installing the PiN in Your Vehicle

First, check the Hard Reset on the bottom of the PiN. If the button is to the left, then remove the
stylus and use it to move the switch to the right.

Choose a suitable position on the windshield where the PiN will be clearly visible by the driver
without obstructing the view of the road. Clean and dry the suction-cup and the windshield. Do
not touch either area after it is cleaned.

1. Insert the four tabs at the end of the suction-mount arm into the four slots on the PDA
cradle. Ensure that the Close arrow on the suction-mount is pointed toward the top
end of the cradle.

2. Slide the suction-mount arm towards the top of the PDA cradle. The cradle should
click into place.

3. Ensure that a memory card has been placed in the PiN’s memory card slot.

See page 17 for detailed instructions on how to insert the memory card.
4. Open the GPS antenna outwards, so that it has a clear view of the sky.
5. Close the side-arms of the PDA cradle so that the PiN is held securely in place.
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6.  Plug the small end of the In-Vehicle Power-Adaptor into the USB/Power Socket on the
bottom of the PiN.
7. Plug the other end of the In-Vehicle Power-Adaptor into the vehicle power-socket.
8. Clean and dry the suction cup and the mounting-area on the windshield, then attach
the suction-mount to the windshield:
a) Hold the suction-cup firmly against the windshield;
b) Press the lever towards the suction-cup.

To remove the PDA windshield suction-mount from the windshield, pull the lever away from the
window and gently lift the tab on the rim of the suction-cup.

20
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9. Basic Skills

Learning to use your PiN is easy. This chapter describes how to use the basic functions of your PiN.

PiN Buttons and the Stylus

On the front of your PiN are four hardware buttons, which each start a different program. There

are also two toggles, one on the front, and one on the side, which can be used to scroll through
menus. Your PiN also comes with a stylus for selecting items and entering information on screen.

The stylus is used instead of a mouse on your Pocket PC. The stylus can be used in the following ways:
. Tap. Touch the screen once with the stylus to open items and select options.

. Drag. Hold the stylus on the screen and drag across the screen to select text and images. Drag in a list
to select multiple items.

. Tap and hold. Tap and hold the stylus on an item to see a list of actions available for that item. Before

a pop-up Menu appears, you will see a circle of dots to notify you of where on the screen you are
pressing. On the pop-up menu that appears, tap the action you want to perform.

Today Screen

When you turn on your PiN for the first time each day (or after 4 hours of inactivity), you will see the Today

screen. You can also display it by tapping - Today. The Today screen presents at a glance important

information for the day.

Tap to switch

Tap to view connection status.
to & program .

Tap to change volume ar mute all souncs

@ Monday, March 24, 2003 —Tap to change date and time:
Dwner: Jack Smith
(123) 555-5937

] John's Birthday

—Tap to open anitem.

——"Your day at & glance

}— “our e-mail messages

— Your active tasks

Tap to create a newitern

21
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The following table explains some of the icons that may be displayed on the Today screen.

Status Icon Meaning

-
* - Turns all sounds on and off; adjusts volume level

Backup battery is low

Main batteries are charging

Main batteries are low

Main batteries are very low

Main batteries are full

Notification that one or more instant messages were received

A IR

e, Notification that one or more e-mail messages were received

NOTE: If more notification icons need to be displayed than there is room to display them, the Notification
icon, e, will display. Tap the icon to view all notification icons.

Programs

You can switch from one program to another by selecting it from the menu. You can customize which
programs you see on this menu. For further information, see Chapter 10. To access a program using this

menu, tap - Programs - program name.

You can activate some programs by pressing a program button. Your PiN has four program buttons on the
front. By default, these activate certain programs. See Chapter 2 for more information.

NOTE: Some programs have abbreviated labels in check boxes and drop-down menus. To see the full

spelling of an abbreviated label, tap and hold the stylus on the label. When you see the full name, drag
the stylus off the label if you do not want to execute the program.

22
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The following table contains a brief description of programs that come preinstalled on your PiN. Additional
applications can be installed from Club Pocket PC at http://www.pocketpc.com.

Program Description

ActiveSync Synchronize information between your PiN and desktop
computer.

Calculator Perform basic arithmetic and computations.

Calendar Keep track of your appointments and create meeting
requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive e-mail messages.

MSN Messenger

Send and receive instant messages with your MSN
Messenger contacts.

Notes

Create handwritten or typed notes, drawings, and recordings.

Pictures

Manage and manipulate image files.

Pocket Excel

Create new workbooks or view and edit Excel workbooks
created on your desktop computer.

Pocket Internet Explorer

Browse Web and WAP sites, and download new programs
and files from the Internet.

sk G IEEEEREENEEE

Pocket Word Create new documents or view and edit Word documents
created on your desktop computer.
Tasks Keep track of your tasks.

Terminal Services Client

Remotely access files and information on a Windows
NT/2000/XP Server.

Windows Media Player 9

Playback multimedia content (videos and sound files).

&| @ [0

SmartsT

SmartST

Navigate using SmartST.

23
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Navigation Bar and Command Bar

The navigation bar is located at the top of the screen. It displays the active program and current time, and
allows you to switch to programs and close screens.

Tap to change wolume of mute the devce.

Tap to quickly s=lect a program
you have recently used

Tap to s=led a program .

Tap to see additional programs
Tap to custommize the device

Use the command bar at the bottom of the screen to perform tasks in programs. The command bar includes
menu names, buttons, and the Input Panel button. To create a new item in the current program, tap New. To
see the name of a button, tap and hold the stylus on the button. Drag the stylus off the button so that the
command is not carried out.

Mew button. |Input panel buttan.

|I\iew Edit Tools (=] E|‘|

Menu Buttons.
names.

Pop-up Menus

You can use pop-up menus to access commonly-used functions. For example, in the contact list, you can
use the pop-up menu to quickly delete a contact, make a copy of a contact, or send an e-mail message. The
actions in the pop-up menus vary from program to program. To access a pop-up menu, tap and hold the
stylus on the item to which you want to perform the action. When the menu appears, lift the stylus, and tap
the action you want to perform. Tap anywhere outside the menu to close it without performing an action.

All Tasks ~ Priority ~
‘ H ‘ i H Tap here to add a new task |

[t Return DV¥Ds

Call Stacey about Friday night
Get stamps at post office
Grocery shopping

Pick up food for dinner

Send out rent money

oooOan

Tap and fold to display
the pop-up menu

Tap outsids the menu

10 close it without perfoming
an action

[1

OGRS
Create Copy
Delete Task

Beam Task...
Liftthe stylus and tap
the actian you want

New Tools 2l

24
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Notifications

Your PiN can notify you of an alarm in a number of ways. For example, if you create an appointment in
Calendar, a task with a due date in Tasks, or an alarm in Clock, you can be notified in any of the following
ways when that activity falls due:

. A message box appears on the screen.

. A sound, which you can specify, is played.

. A light flashes on your PiN.

To choose reminder types and sounds for your PiN, tap & I - Settings > Personal tab > Sounds &
Notifications. Choose the event and your preferred notification method in the Notifications tab. Set the
volume and types of warnings you wish to allow in the Volume tab.

Entering Information on Your PiN

You have several options for entering new information:

e Use the input panel to enter typed text, either by using the soft keyboard or another input method.

e Write directly on the screen.

e Draw pictures on the screen.

e Record a message using the microphone on your PiN.

e Use Microsoft ActiveSync to synchronize or copy information from your desktop computer to your PiN.

For more information on ActiveSync, see ActiveSync Help on your computer.

Entering Text Using the Input Panel

Use the input panel to enter information in any program on your PiN. To enter type, you can use the soft
keyboard, Letter Recognizer, Block Recognizer, or Transcriber. In any case, all entered characters appear as
typed text on the screen.

Tap the arrow next to the Input Panel button to view the alternative input methods. Tap on your preferred
method to select it.

Options...

Block Recognizer
» Keyhoard

Letter Recognizer

Transcriber

Select an input method .

New Edit ¥iew Tools *, Tap to see your choices.

Input Panel buﬂon.|
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When you use the input panel, your PiN anticipates the word you are typing or writing and displays it above
the input panel. When you tap the displayed word, it is inserted into your text at the insertion point. The more
you use your PiN, the more words it learns to anticipate.

ok
Monthly mee e

= Tap here ifthis
| meeting] | isthe right word

shift[z [x [c[v]b]n[m],[.][7]
ctfad] " T ] [4]t]<]=
New Edit Tools [ 2 =g

Word Completion options:

Pocket PC will attempt to predict the word that you enter as you type by doing a dictionary lookup. Your PiN
comes with a preinstalled dictionary, which includes a range of common words. As you enter words that do
not feature in that dictionary, they will automatically be added to a custom user dictionary that will also be
used to suggest the word you are entering. To change how word completion works, tap the arrow next to

E|A

the Input Panel button - Options > Word Completion tab.

Input

Suggested words pop-up in a window above
the input panel. Tap to accept,

Suggest words when entering kext
Suggest after entering letter(s)
Suggest word{s)

Add a space after suggested word

Replace text as you bype

Input Method | Word Completion | ©ptions

IF skylus taps become inaccurate, align the
touch screen,

2|

These options allow you to turn word completion on or off, allow you to adjust at what point the full word
should be predicted, and whether or not text should be replaced while you type.

To type with the soft keyboard:

1. Tap the arrow next to the Input Panel button and then Keyboard.

2. On the soft keyboard that is displayed, tap the keys with your stylus.

26
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The soft keyboard can be used in three modes: small, large with gestures enabled, and large without
gestures enabled. The larger modes gives the advantage of larger keys and therefore higher accuracy; the
small mode allows you to view the soft keyboard in a style similar to a standard QWERTY keyboard. The
different keyboard modes are shown on below, and the way to switch between them is set out on page 28.

123(1]2[3]4[5]a|7[8][0]0]-[=]«
Tabla[wle[r[t[y[ulifo[p[[]]
CaPla[s[d[f[a[h][j[k[I[:]"]
shittfz[2[c[v[b][n[m]. [.]/]

ctlai] - [ ] [V[t]e]=
MNew Edit Yiew Tools T, IEH

By default, your PiN displays the small keyboard with on-screen special commands.

=l alwle[r[t[y[uli]o]p]*
Tabla[s|d][f[a[n]i]k]1]-
Shift|z|x|c|v|h|n|m H
culat] @] & ARRE

MNew Edit Yiew Tools T,

0

If you choose to view the large keyboard without gestures enabled; the special commands remain, but you
must tap the button in the top left-hand corner in order to enter numbers.

123) 1| 7% 54 %[5 |7%8" [
Tbjg|(w|e|r|t|¥y|u|il|oO
difals[d|[f]a[n]j[k]I
ctyl]z[x[c[v[b[n[m] <].>],?
MNew Edit Yiew Tools T, |~

If you choose to view the large keyboard with gestures enabled, you can enter numbers without tapping
through to another keyboard, but you can no longer tap to use special commands. You can activate these
commands using the following methods.

1. To space forward, swipe the stylus horizontally across the keyboard in a forward direction.

2. To move backwards, swipe the stylus horizontally across the keyboard in a backwards
direction.

3. To carriage return, swipe the stylus vertically downwards on the keyboard.

4., To shift + key, place the stylus on the key and swipe vertically upwards across the keyboard.

N
~
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To amend soft keyboard options:

With Keyboard selected as the input method, tap the arrow next to the Input Panel button

Options.

This activates the Input Method screen, i
screen can also be reached by tapping

To use Letter Recognizer:

Input

Input methad:

O Large keys Hn
@ Small keys mnm

|:| Use gestures For the Following keys and
remave them from the keyboard

Ep Space |i| Shift + ley
E Backspace |1| Enter
Input Method | Word Completion | Options

If stylus taps become inaccurate, alignthe
touch screen.

2|

|.

and tap

hich you can set the keyboard to your preferred mode. This
- Settings > Personal tab = Input = Input Method tab.

With Letter Recognizer you can write letters on screen using the stylus just as you would on paper. It uses
P , ®
technology similar to that of CIC’s Jot™ product.

1. Tap the arrow next to the Input Panel button and then Letter Recognizer.

2. Write a letter in one of the boxes.

-

«~ |3

! [2RE

7[5

MNew Edit Yiew Tools T,

2]

Text that you write in the first box is displayed as upper-case; text entered in the second as lower-case, and

the third box is used to enter numbers.
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Click on the button to open a panel of symbols and special characters to enter into your text.

New Edit Yiew Tools T,

e E % B 1
AR ENnee

<> [1]1]\]-]=
° ¢ |8|i|i|€|E

Foreign characters as well as general purpose special characters can be entered using this keyboard. Tap

the Ii‘ button to return to the Letter

To amend Letter Recognizer

Recognizer pane.

options:

|4..

With Letter Recognizer selected as the Input Method, tap the arrow icon next to the Input Panel L,

and tap Options.

&g 4a3

Input

Input method:

‘ith Block Recognizer you can input characker
strokes you may have learned using Grafittid
From Palm, Inc.

Input Method | Word Completion | Options

IF skylus baps become inaccurate, align the
touch screen,

£




PiN 570 | User Manual

Tap the Options button.

|5ettings & 443 D

Letter Recognizer: Options

[ Quick stroke
[ right to left crosshar
[ Allow accented characters

£

Quick Stroke lets you write all letters using one stroke. While this method will allow you to write faster, you
may have to learn to form letters in a new way.

You should enable Right to left crossbar if you form crossbars on ‘'t’, ‘', and ‘+’ from right to left. Many left-
handed people do this.

Allow accented characters enables the recognizer to predict whether your inputted characters should have
accent marks. For example, &.

To use Block Recognizer:

With Block Recognizer you can input character strokes using the stylus that are similar to those used on
other PiNs such as Palm Pilots. It uses technology similar to that of Paim’s Grafitti® product.

1. Tap the arrow next to the Input Panel button and then Block Recognizer.

2. Write in the appropriate box. You should enter letters in the box on the left, and numbers in the box on

the right.

Elal 123 4m
|
4—1[5P2]

| 7%

New Edit Yiew Tools T, &~

All the text that you enter is presented as type on the screen. Click on the button to open a panel of
symbols and special characters to enter into your text.

To amend Block Recognizer options:
Currently there are no options for this input method.
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To use Transcriber:

With Transcriber you can write anywhere on the screen using the stylus just as you would on paper. Unlike
Letter Recognizer and Block Recognizer, you can write a sentence or more of information.

1. Tap the arrow next to the Input Panel button and then Transcriber.
2. Write anywhere on the screen.
3. Transcriber will change the written characters to typed characters.

For help using Transcriber, tap the question mark in the lower right hand corner of the screen.

To select typed text:
To select typed text, drag the stylus across it.

Entering a date in an application:
Many applications ask you to input a date. All standard Pocket PC applications use the same form to assist
in this process.

4 [ 8 j2003 -

First, click on the arrow to the right of the date field.

4 2 f2003 A

April 2002 X
S MTWTF S

03 1EE: 4 S
€ 7 8 9 10 11 12
13 14 15 16 17 18 19
20 21 22 23 24 25 26
27 282030 1 2 3
4 5 6 7 8 9 10
Today: 4/2/03

Next, select the date by moving among months using the arrows in the upper left- and right-hand corners.
When you have found the date you want, tap the date to enter it. You can enter the current date by clicking
Today: ...

Writing on the Screen

You can use your stylus to write directly on the screen in any program that accepts writing, such as Notes.
You can also write directly on the screen in the Notes tab in Calendar, Contacts, and Tasks.

w
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To write on the screen:

Tap the Pen button to switch to writihng mode. This action displays lines on the screen to help you write.

=

New Edit Tools (= [

Tap the Pen button and use
your stylus like a pen.

NOTE: Some programs that accept writing may not have the Pen button. See the documentation for that
program to find out how to switch to writing mode.

To select writing:

If you want to edit or format writing, you must select it first.

1. Tap and hold the stylus next to the text you want to select until the insertion point appears.
2. Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Edit - Undo and try again. You can also select text by tapping
the Pen button to deselect it and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with typed text: tap and hold the
selected words and then tap an editing command on the pop-up menu, or tap the command on the Edit
menu.

To convert writing to text:

If you want to convert your handwritten notes to typed text, tap Tools = Recognize. If you want to convert
only certain words, select them before doing so. Alternatively, tap and hold the selected words and then tap
Recognize on the pop-up menu. If your PiN does not recognize a word, it will not convert it to text. In this
instance, your writing will be left as it appears on screen.
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.
<
o
R

Copy

Clear

Recognize

;w Edit Tools (= |7 E|A New Edit Tools |4 E|‘

Seled the text you want
to coment andtap Recognize on the The witing is turned into
POp-Lp MEenu. text

If your PiN converts your text to the wrong word, you can select the correct word from a list of alternates or
you can return to the original writing. To do so, tap and hold the incorrect word (tap one word at a time). On
the pop-up menu, tap Alternates. A menu with a list of alternate words appears. Tap the word you want to
use, or tap the writing at the top of the menu to return to the original writing.

Nutes &g aze 63

Toens/ |
ﬂ t fO 0 /Q T/ gggifamm; your
report!
Report!

o, tap the sword you want
0 Lse.

ofn]) [I——]«|n]u

New Edit Tools [] 7] =8

Tips for getting good recognition:

Write neatly.

Write between the lines. Keep the crosses of “t” and apostrophes and periods and commas within the
lines between which you are writing.

For better recognition, try increasing the zoom level to 300% using the Tools menu.

Write the individual letters of a word close together. Leave big gaps between words so that the PiN can
tell where words begin and end.

Avoid words that cannot be converted. These include hyphenated words, foreign words that use
special characters such as accents, and some punctuation.

NOTE: If you add writing to a word to change it (such as changing a “3” to an “8”) after you attempt to
recognize the word, the writing you add will not be included if you attempt to recognize the writing again.




PiN 570 | User Manual

Drawing on the Screen

You can draw on the screen in the same way that you write on the screen. The difference between writing
and drawing on the screen is how you select items and how they can be edited. For example, selected
drawings can be resized, while writing cannot.

To create a drawing:

. Cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or touching
the drawing box become part of the drawing. Drawings that do not cross three ruled lines will be

treated as writing.
kg
Notes < 4:29 &4

Py

X 2

————The drawing box indicates

O = the houndatiss of the dravving.
-

New Edit Tools E|A

|Pen button

NOTE: You may want to change the zoom level so that you can more easily work on or view your
drawing. Tap Tools and then a zoom level.

To select a drawing:

If you want to edit or format a drawing, you must select it first.

. Tap and hold the stylus on the drawing until the selection handle appears. To select multiple drawings,
deselect the Pen button and then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and then
choosing the appropriate command on the pop-up menu. Alternatively, choose the command from the Edit
menu. To resize a drawing, make sure the Pen button is not selected, and drag a selection handle.

NOTE: For more detailed information about the Notes application, please see “Notes: Capturing
Thoughts and Ideas,” on Page 50.

Support for clip-on keyboards

You may be able to attach a snap-on keyboard to your PiN (see your PIN manufacturer for supported
keyboards for your PiN). Snap-on keyboards allow you to enter text on a physical keyboard, and allows you
to use number of standard keyboard shortcut commands, such as CTRL+C, copy; CTRL+Z, undo; CTRL+V,
paste; etc. Additionally, most Pocket PC applications now support keyboard mnemonics, meaning you may
be able to access menu items without using the stylus on the screen.
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Recording a Message

In any program where you can write or draw on the screen, you can also quickly capture thoughts,
reminders, and phone numbers by recording a message. In Calendar, Tasks, and Contacts, you can include
a recording in the Notes tab. In the Inbox program, you can add a recording to an e-mail message. In the
Notes program, you can either create a stand-alone recording or include a recording in a written note. If you
want to include the recording in a note, open the note first

To create a recording:

1. Tap the Record button on the Recording toolbar.

2. Hold your PiN’s microphone near your mouth or other source of sound.
2. Make your recording.

4. To stop recording, tap the Stop button on the recording toolbar.

To play a recording, tap it in the list or tap its icon in the note.

Motes o {2 420 €3

nelicats s an
recording.

Quote
from Adam
‘ =— Tapto begh recarding
o[a]) [[—— EX
New Edit Tools =18

Tap to showor hide
the Recording toslsar

Using My Text

When using Inbox or MSN Messenger, use My Text to quickly insert preset or frequently used phrases into
your messages. To insert a phrase, tap My Text and tap a message from the menu.

MSNMessenger  oF ¢ 316 (DY

Hi, Can you meet at 2007

1 hawe another appointment scheduled For 2:00,
but am awaila

Yes.

No.

1 can't talk right now.

T'll be right there.

I ing late.

Last messagg m running fate

Where are you?

123123 Hi

Tab/ g |w[d
a Goodbye.

Call me later.

a6~ [{ !lovemy Pocket PCt
Taols Chats|My Text| 3, =18

Tapto select a
prevwitten m essage.

w
)]
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You can edit a My Text message by tapping Tools - Edit > My Text Messages.

Select the message you wish to edit and make desired changes

My Text Messages

Tap a message, then edit below,

Yes,

Mo.

Tharks.

Please call my mobile.
Please call my assistant.
T'l be right there.

I'm running late.

Z]+

. Tap OK to save changes.
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10. Managing Your Pocket PC

Find and Organize Information
Use the Find feature on your PiN helps you quickly locate information.
Tap -> Find. Enter the text you want to find, select a data type, and then tap Go to begin searching.

You can elect to search all data on your PiN, or specific programs. To find data that is taking up storage
space on your PiN, select Larger than 64 KB in Type.

Using File Explorer

You can also use the File Explorer to find files on your PiN and to organize these files into folders.

Tap 7 - Programs - File Explorer. Other operations you can undertake from File Explorer includes cut,
copy, paste, rename, delete, send via e-mail, and beam file.

Customize Your PiN

You can customize your PiN by adjusting PiN settings or installing additional software. To adjust PiN settings,

Among the settings you can adjust are:

. Clock, in which you can change the time or set alarms.
. Owner Information, to enter your contact information.
. Password, to limit access to your PiN.

. Power, to maximize battery life.

. Today, to customize the look and the information that is displayed on the Today screen.

w
~
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Changing Password settings:

Password

Prompt if device unused
for

@ Simple 4 digit password
O Strong alphanumeric password

Password: 2555

o
D D
o

ENTR

Passwiard ‘ HirE |

2]

To set or change a password on your PiN, tap 24 - Settings - Password. You can choose between a
simple 4-digit numerical password or a stronger, alphanumeric password. Before setting your password, set
the amount of time after which your PiN will lock if you have not been using it. Then select the type of
password you want, and enter your password. If you wish, you can enter a hint to remind you of your
password should you forget it. To do so, activate the Hint screen and enter your password hint. When
prompted, tap Yes to set your password.

NOTE: If password protection is enabled, you will always be prompted for password after a soft reset or
upon power up in addition to the specified frequency.

Adding or Removing Programs

Programs installed on your PiN at the factory are stored in ROM (read-only memory). You cannot remove this
software. ROM programs can be updated using special installation programs with a *.xip extension. All
programs and data files added to your PiN after factory installation are stored in RAM (random access
memory).

You can install any program created for your PiN, as long as your PiN has enough memory. The most

popular place to find software for your PiN is on the Pocket PC Web site
(http://www.microsoft.com/mobile/pocketpc).
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To add programs using ActiveSync

You will need to install the appropriate software for your PiN on your computer before transferring it to your
PIN. For information on installing ActiveSync on your computer, see pages 15-16.

1.

Once installation is complete, tap

Determine your PiN and processor type so that you know which version of the software to install.

Tap 4 > Settings > System tab-> About-> Version tab. Make a note of the information.
Download the program to your computer (or insert the CD or disk that contains the program into your
computer). You may see a single *.xip, *.exe,, or *.zip file, a Setup.exe file, or several versions of files
for different PiN types and processors. Be sure to select the program designed for the Pocket PC and
your PiN processor type.

Read any installation instructions, Read Me files, or documentation that comes with the program. Many
programs provide special installation instructions.

Connect your PiN and desktop computer.
Double-click the *.exe file.

. If the file is an installer, the installation wizard will begin. Follow the directions on the screen.
Once the software has been installed on your desktop computer, the installer will automatically
transfer the software to your PiN.

. If the file is not an installer, you will see an error message stating that the program is valid but it
is designed for a different type of computer. You will need to move this file to your PiN. If you
cannot find any installation instructions for the program in the Read Me file or documentation,
use ActiveSync Explore to copy the program file to the Program Files folder on your PiN. For
more information on copying files using ActiveSync, see ActiveSync Help.

[,’ - Programs, and then the program icon to switch to it.
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To remove programs using ActiveSync

1.

Launch ActiveSync and select Tools—Add/Remove Programs.

g

Neze: IF th, L it oot fisted, thy
ol desagred 1o be uved on pou mobde devece,

Saftware Company’s Product BEEAAK =
D10 Software Company’s Product AECET
Oy Software Company’s Product

gy saftwara Company’s Product neEk =]
 Pangiam desesiplicn

Space requied for selected peograma: QoK
Space awailable on devics: mER2K

[ bl progrann inlo the defauk installstion fkde

1~ Remove hom both kcatons:

T veemrre e sedecled program from both
B el : femoes.. |

[k | coa | nee |

Highlight the name of the application you wish to remove from your PiN.
Click Remove

Follow the on-screen instructions

To add a program directly from the Internet

1.

Determine your PiN and processor type so that you know which version of the software to install.
- Settings > System tab-> About-> Version tab. Make a note of the information

Tap L&

Download the program to your PiN straight from the Internet using Pocket Internet Explorer. You may
see a single *.xip, *.exe or *.zip file, a Setup.exe file, or several versions of files for different PiN types
and processors. Be sure to select the program designed for the Pocket PC and your PiN processor

type.

Read any installation instructions, Read Me files, or documentation that comes with the program. Many
programs provide special installation instructions.

Tap the file, such as a *.xip or *.exe file. The installation wizard will begin. Follow the directions on the
screen.
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To add a program to the Start menu

Tap ’ - Settings > Menus - Start Menu tab, and then the check box for the program. If you do not
see the program listed, you can use File Explorer on the PiN to move the program to the Start Menu folder.
Alternatively. use ActiveSync on your computer to create a shortcut to the program and place the shortcut in
the Start Menu folder.

. Using File Explorer on the PiN: Tap - Programs - File Explorer, and locate the program. Tap
and hold the program and tap Cut on the pop-up menu. Open the Start Menu folder located in the
Windows folder, tap and hold a blank area of the window, and tap Paste on the pop-up menu.

The program will now appear on the & menu. For more information on using File Explorer, see “Find
and Organize Information,” earlier in this chapter.

. Using ActiveSync on your computer: Use the Explorer in ActiveSync to explore your PiN files and
locate the program. Right-click the program, and then click Create Shortcut. Move the shortcut to the

Start Menu folder in the Windows folder. The shortcut now appears on the - menu For more
information, see ActiveSync Help.

To remove programs

g - Settings > System - Remove Programs.

Remove Programs

Programs in storage memory:

Software Product 1
Software Product 2
Software Product 3
Software Product 4

Remove

Total storage memeory available: 28500k

Adjust memory allocation.

=18

If the program does not appear in the list of installed programs, use File Explorer on your PiN to locate the
program, tap and hold the program, and then tap Delete on the pop-up menu.
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11.

Installing Outlook 2002

Microsoft Outlook 2002 provides an integrated solution for managing and organizing e-mail messages,
schedules, tasks, notes, contacts, and other information.

Using ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your
computer with Pocket Outlook on your PiN. You can also synchronize this information directly with a
Microsoft Exchange server. Each time you synchronize, ActiveSync compares the changes you made on
your PiN and desktop computer or server and updates both computers with the latest information.

For information on using ActiveSync, see Using ActiveSync on pages 15-16.

Installing Outlook 2002 on Your Computer

1.

2.

Turn on your Windows-based/IBM-compatible computer and allow Microsoft Windows to start.

Insert the PIN Companion CD into the CD drive of your computer.
The Getting Started with Your Pocket PC™ window will open.

Click Getting Started With Windows Mobile or wait for the Getting Started With Your Windows
Mobile™ - based Pocket PC screen to appear.

Click Start Here.
The Start Here screen will display.

Click Install Outlook 2002 in the left-hand column.
The Install Microsoft® Outlook” 2002 screen will display.

Click Install and follow the on-screen prompts to install Microsoft Outlook.
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12. Microsoft Pocket Outlook

Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use these
programs individually or together. For example, e-mail addresses stored in Contacts can be used for sending
e-mail messages in Inbox.

Using ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your
computer with your PiN. You can also synchronize this information directly with a Microsoft Exchange server.
Each time you synchronize, ActiveSync compares any changes you have made in your PiN and your
computer or server. It then updates both computers with the latest information.

You can switch to any of these programs by tapping them on the menu.

Calendar: Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events. You can check your
appointments in one of several views (Agenda, Day, Week, Month and Year) and easily switch views by
pressing the buttons below:

E Agenda View Upcoming appointments appear in bold; past appointments are not
E Day View View your day’s schedule in 30-minute blocks
@ Week View View your week’s schedule in one-hour blocks
@ Month View View your month in 12-hour blocks
i;'-.l_ Year View View a year calendar

alendar o 4Z %43 9

Mar 24,03 SEJTwWTES B TF Toetoooiotoday.

Conference call with Microsoft
1:30p-2:30p (My office)

Meeting with Tom Tapto display or edi
3i30p-5:00p (Bldg 31 Room 432) the appoirtm ent details

New Tools E E @ Z|‘

|Tap to creste & newappointment.
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To create an appointment:

1. If you are in Day or Week view, tap the desired date and time for the appointment.

2. Tap New.

3. Using the input panel, enter a subject and a location.

4. You can change the date or time of the appointment by tapping on the relevant field.

5. Enter other desired information such as status (Free, Tentative, Busy, Out of Office) or Sensitivity
(Normal or Private). You will need to hide the input panel to see all available fields.

6. If this appointment occurs more than once, click the text “Once” next to the Occurs field and select
among the drop-down options.

i Choose between weekly, monthly, or yearly appointments. Alternatively, you can edit the
recurrence pattern. Click Next to move to the next screen.

ii. Indicate when this pattern should begin and terminate. Click Finish to save changes.

7. You can add your appointment to a category if you wish. Click on the Categories field to begin.
i Choose one or more of the available categories.
ii. Alternatively, select the Add/Delete tab to define new categories.

Enter the name of the category and press the Add button. To delete a category, highlight the
appropriate category and press Delete.

8..  When finished, tap OK to return to the calendar.

NO
in - Settings > Personal tab > Sounds & Reminders.

: If you select Remind me in an appointment, your PiN will remind you according to the options set

Using the Summary Screen

When you tap an appointment in Calendar, a summary screen is displayed. To change the appointment, tap
Edit.

To add notes to an appointment, tap the Notes tab from the Edit Appointment screen.

You can enter text, draw, or create a recording. For more information on creating notes, see “Notes:
Capturing Thoughts and Ideas,” on page 50.
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Calendar &t o€ 343 0

s

Lunch w/ Adam £
12:00p-1:00p Sun, 8/6/2000 ——iew appoirtment details.
Corner Cafe
Remermber portfolio. — Ve
Edit Tools =
]

| Tap to change
appaintment .

Creating Meeting Requests

You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request will
be created automatically and sent either when you synchronize Inbox or when you connect to your e-mail
server. You can choose how you want meeting requests sent by tapping Tools = Options. If you send and
receive e-mail messages through ActiveSync, select ActiveSync.

To schedule a meeting:
1. Create an appointment.

Categories: MO CATRQONES. ..
[ Attendees: Mo attendees... ]
Status: Busy
Sensitivity: Mormal

Appainkrient | Mokes |

Edit 2|+

2. In the appointment details, hide the input panel, and then tap Attendees.

3. Select the meeting attendees from your Contacts. To be invited, your Contacts must have e-mail
addresses.

The meeting notice is created automatically and placed in the Outbox folder after the above screen is
accepted.

Beaming Appointments
1. Highlight the applicable appointment in Agenda or Day view.

2. Select Tools, Select Appointments
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yaour calendar?

New ¥iew Tools E|‘

3. Select Yes on the destination PiN.

Contacts: Tracking Friends and Colleagues

Contacts maintains address details for your friends and colleagues for easy retrieval at home or on the road.
Using the PiN infrared (IR) port, you can quickly share Contacts information with other PiN users.

Seled the category of contacts
yiou et displaeed in the list.

ontacts

All Contacts ~ Find a name

#ab|cde| foh I {opa | rst (L] vz

Smith, Jack {123) 555-7548
Send Email

—Tap and erter part of a nameto
quickly find it in the list.

—Tap to display or edit
the cortact details.

Beam Contack...
Delete Contact

Tap and hold to display
& pop-up menu of actions.

Ne‘w View Tools E|‘

Tap to create & new contact
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To create a contact:

1. Tap New.

Tap to retum to the contact
ligt ithe cortact iz saved

autorm atically).
Mame: hl P's
Job title: :
Department: a
Company:
Work bel:
wiork Fax:
Work addr: -
E-mail: | |
Moile kel ~— Scroll to see more fields.
Ditails | Motes l Nates is @ gaod place
123'1|2|3|4|5|5|7|3|9|D|- |:|‘ for maps and directions
Tab[a[wle[r [t]yui]o]p|I]]
caPlafsd]fla[n]ilk[1];]"]
shitt[ z[x[c[v[b[n[m].[.[/][+
ctfad]* [\ | Lt <]
Edit =B

2. Using the input panel, enter a name and other contact information. You will need to scroll down to see
all available fields.

3. To assign the contact to a category, scroll to and tap Categories and select a category from the list. In
the contact list, you can display contacts by category. Click on the Categories field to begin.

i Choose one or more of the available categories.
ii. Alternatively, select the Add/Delete tab to define new categories.

Enter the name of the category and press the Add button. To delete a category, highlight the
appropriate category and press Delete.

4.  To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information
on creating notes, see “Notes: Capturing Thoughts and Ideas,” on page 50.

5. When finished, tap OK to return to the contact list.

Finding a contact

There are four ways to find a contact:

. In the contact list, enter a contact name in the box under the navigation bar. To show all contacts
again, clear text from the box or tap the button to the right of the box.

tacts o 42326 €3

icks « |Find a name |

[ o] ik Trmnlooa | est el e
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. In the contact list, tap the drop-down list labeled All Contacts by default. Select the type of contact
that you want displayed. To show all contacts again, select All Contacts. To view a contact not
assigned to a category, select No Categories.

. To view the names of companies your contacts work for, in the contact list, tap View > By Company.

* By Name
By Company

New (Yiew|Tools

The number of contacts that work for each company in your address book will be displayed to the right

of the company name.

. Tap

Using the Summary Screen

- Find, enter the contact name, select the type Contacts, then tap Go.

When you tap a contact in the contact list, a summary screen is displayed. To change the contact

information, tap Edit.

Beaming Contacts

#|Contacts o d2 413 O

Harry Smith

-

Mohile Solutions

WP Marketing ‘
Saftware Corporatian

|
ork Faxc| |
Work. addr

(123) 555-3821
100 Carmpus Park
Anytown, 20 33943
harrysm@software, soft E-mail
(123} 595-6957 Mobile tel |
weww, softweare, soft Web page
(123} 555-9858 Home tel|_|

(1231 555-5085 Assistant tel |7

Surnmary | Motes

Edit Tools £~

l—Tap 10 chahge contact information.

1. Select Tools—Beam Contacts

2. Select Yes on the destination PiN.

wiewwcontact details.

Tap to viewnotes.
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Tasks: Keeping a To Do List

Use Tasks to keep track of what you have to do.

All Tasks - Priority =

| ' | 1 ” Tap here to add a new task ‘

[]* ReturnD¥Ds

[ call Stacey about Friday night

|:| Get stamps at post office

[0 Grocery shopping

[0 Pick up food for dinner

[0 Send out rent money

[T Tap and hold to display
Create Copy the pop-up menu.
Delete Task ——— Tap outside the menu
— to close it without performing
Beam Task... an action.

— Litt the stylus and tap
the action you want
New Tools 4 |A

To create a task:

6.

Tap New.
Using the input panel, enter a Subject.

You can enter a start date and due date or enter other information by first tapping the field. If the input
panel is open, you will need to hide it to see all available fields.

To assign the task to a category, tap Categories and select a category from the list. In the task list,
you can display tasks by category. See adding categories to appointments in “To create an
appointment” above in the section describing Calendar for more information about categories.

To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information
on creating notes, see “Notes: Capturing Thoughts and Ideas,” on page 50.

When finished, tap OK to return to the task list.

NOTE: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap Tap
here to add a new task and enter your task information.
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Using the Summary Screen

When you tap a task in the task list, a summary screen is displayed. To change the task, tap Edit.

31
Call Stacey W— f»ﬂo:etr;lsm::;khas heen sat

—iewriask details.

Starts: 41372003

De 4f3/2003
/3 £ —Tapto showwand hide addtional

summary inform ation

Be pleasant--her cat recently got sick.

“iewnotes.

Edit Tools (=]

l—Tap to change task

Notes: Capturing Thoughts and Ideas

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can also create a
recording. If a note is open when you create the recording, it will be included in the note as an icon. If the
note list is displayed, it will be created as a stand-alone recording.

Notes 9 9
@AII Folders - Name | Tap to change the sot
orcler ofthe list.

Business1 8:54a 424b
Outlook Notes1 8:54a 428h
8:54 a 424b

Tap to open & note or
play a recording.

Tap and hold to display
Select all & pop-up menu of actions.

Send via E-mail...

Rename/Move...

Tap to record

Rkl

e[l [——]

New Tools

—Tap to showor hide the
Recarding toolbat.

|Tap to create a new item
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To create a note:
1. Tap New.

2. Add text to your note.

i Raise the input method chooser E|A and choose an appropriate type.

ii. Type normally or use the stylus to write text
3. Add drawing to your note
Press the Drawing button on the toolbar.
ii. Use the stylus to create drawings
iii. Manipulate the corners of the drawing element to stretch/skew or rotate.
4. Add voice recording to your note
Press the Record button on the toolbar

ii. Press ® to begin recording.

iii. Press ol to adjust volume levels.

5. Hit ok to automatically save (you will not be prompted for a file name)

Inbox: Sending and Receiving E-mail Messages
Use Inbox to send and receive e-mail messages in either of these ways:

. Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop
computer.

. Send and receive e-mail messages by connecting directly to an e-mail server through an Internet
service provider (ISP) or a network.

Synchronizing E-mail Messages

E-mail messages can be synchronized as part of the general synchronization process. You will need to
enable Inbox synchronization in ActiveSync. For information on enabling Inbox synchronization, see Installing
ActiveSync on Your Computer on page 15.

During synchronization:
. Messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the
ActiveSync folder in Inbox on your PiN. By default, you will receive messages from the past three days

only, the first 100 lines of each message, and file attachments of less than 100 KB in size.

. E-mail messages in the Outbox folder on your PiN are transferred to Exchange or Outlook, and then
sent from those programs.

. E-mail messages in subfolders must be selected in ActiveSync on your desktop computer in order to
be transferred.
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Connecting Directly to an E-mail Server

In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail
messages by connecting to an e-mail server using a modem or network card connected to your PiN. You will
need to set up a remote connection to a network or an ISP, and a connection to your e-mail server. For more
information, see Chapter 16.

When you connect to the e-mail server, new messages are downloaded to the PiN Inbox folder, messages in
the PiN Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from
the PiN Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your
computer. When you delete a message on your PiN, it is also deleted from the e-mail server the next time
you connect based on your ActiveSync settings.

You can work online or offline. When working online, you read and respond to messages while connected to
the e-mail server. Messages are sent as soon as you tap Send, which saves space on your PiN.
Using the Message List

Messages you receive are displayed in the message list. By default, the message list is in date order, with the
most recently received message at the top.

Select the s2rvice and folder
you vant to display.

Received Date =~ —Seledt the sort orcer
r messages

Tapto open & message

E" Mo 10:46 AM 4K =
What does NONI do to benefit yo... |

E" Best Rates 10:32 AM 3K
The refi boom! Save thousands! ...

E" Hidden Gems  10:31 AM 3K
Houses for sale from $10,000 - ...

E" Sale@Clearan.. 9:48AM 3K
Your first stop for savings!

(& Passion Si16AM 3
#tok Take A Beautiful Journgy! *+*

E" itsImazing 9:03 AM 3K
Welcome New Member!

" Florida Yacati... 8:41 AM 3K
4 Days - 3 Nights with two Unive.. |*

Inbos: Work 46 Ttems, 44 Unread.

New Tools Accounts [ =]

Tap to connect andto
s=nd and receive e-mail.

Tap to connect to
the selected service
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When you receive a message, tap it to open it. Unread messages are displayed in bold. Below is a legend to
some of the message status icons:

Meeting Request

Unread partially-downloaded message

Unread message to be downloaded

Unread downloaded message

Unread downloaded message with attachments

Read partially-downloaded message

Read downloaded message

Read downloaded message with attachments

BB 6B H Y T8

Upon connection to a live mail server, your PiN will display a progress and status bar for that connection.

By tapping and holding on any message, you will be presented with the following menu. Tap on any of the
options to take that action.

New
Delete
Move...

Reply
Reply all
Forward

Send/Receive
Mark as Read
Mark for Download

When you connect to your e-mail server or synchronize with your desktop computer, by default, you will
receive messages from the last three days only, the first 100 lines of each new message, and file attachments
of less than 100 KB in size.

You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server
connection. In the message list, tap and hold the message you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list give you visual indications of message status.

You specify your downloading preferences when you set up the service or select your synchronization
options. You can change them at any time:

. Change options for Inbox synchronization using ActiveSync.
. Change options for direct e-mail server connections in Inbox on your PiN. Tap Tools and then tap

Options. On the Service tab, tap the service you want to change. Tap and hold the service and select
Delete to remove a service. See “Configuring an Inbox Account” below.
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Replying to Meeting Invitations

When meeting invitations arrive in your Inbox, you can view them just like normal e-mail messages.

& gz zar D

From: "Jared”

Location: Building & Room 140
when: 3/25/03, 5:00 &M - 5130 AM
Subject: Updated: Meeting with John
Stakus: Please respond.

b3
¥

The content of this message is in a format that
cannot be displaved.

New Edit 7% B Ef 4@ @ £|A

The header of the e-mail differs from standard e-mail messages.

Decline

Tentative

New Edit|§||;—=;< = a o

>
Clicking the 5’ button allows you to accept, decline, or tentatively accept the meeting invitation.

Opening vCard (.VCF) Attachments

vCards are electronic business cards. It is a powerful means of Personal Data Interchange (PDI) that is
automating the traditional business card. You can receive these files as e-mail attachments and save them to
your Contacts database.

From: "Jared"

Subject; Contact information
Sent: 4/19/03 6:10: 16 PM

4

Attached is Jack's conkact information,

F=]1ackHan...
it = = @ 9 E|A
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Once you are viewing an e-mail with a vCard (.VCF extension) file, single click on the vCard.

ELuja) i e g e e g g L

Do you want to save "™ to
your device?

Tap Yes to save this contact when prompted.

Composing Messages

To compose an e-mail message:

1. Tap New.

Tap to s=nd the message

¥ —Tapto showor hide
the complete header.

Jack Smith
Voice: 123-555-3398

Edit My Text [ [= 2+

Tap to show ! hide the
recording toolbar,

Tap to displaythe address Book.

Tap to inset common messages.
2. In the To field, enter the e-mail addresses of one or more recipients, separating them with a semicolon.
Alternatively, select a name from the contact list by tapping the Address Book button. Your PiN will
display in the Address Book all e-mail addresses entered in the e-mail fields in Contacts.

When you begin typing in the name or e-mail address of a contact, your PiN will suggest addresses in
its memory based on the characters you have entered.

Alternatively, you can display the Address Book and manually browse for contacts. Search for
contacts by entering parts of their name where it says “Find a name”.

3. Compose your message. To enter preset or frequently used messages, tap My Text and select a
message.

Pressing Edit brings up a number of available features. You can cut, copy, paste, clear, and select all
text. You can edit My Text messages (see “Using My Text” on page 35).

i. You can add an attachment.
ii. You can spell check a message.

iii. You can check the recipient names against your contacts list.

(o))
(&3]
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iv. You can change the language of the message.
v. You can save a copy of the message to your drafts folder for later access.
vi. Finally, you can cancel the message

4. Tap Send when you've finished composing the message. If you are working offline, the message is
moved to the Outbox folder and will be sent the next time you connect.

Working with Inbox Accounts

Connect
Clear Work

New Account...
Accounts...

ActivesSync
* Work

The Accounts menu (available from the main Inbox window) allows you to connect to mail accounts to
download/send messages, remove all messages from the selected account, create a new account, view
existing accounts, or switch between available accounts.

NOTE: Switching between available accounts means that clicking Connect will connect to that account
and the folders visible immediately from the folder tree view pertain to that account.

Options

Accounts:

* Corporate Mail
Work

Accounts | Message | Address | Storage |

Vs
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Creating a new Inbox Account

Select Accounts, New Account from the main window or the New... button from Accounts, Accounts to
define a new account.

E-mail Setup {1/5) 0

E-mail address

Enter e-mail address:

jack@software, soft]

| complete |

|Eancel || Back || Next

Edit 3 E|A

1. First enter an e-mail address.

E-mail Setup {2/5) 0

Auto configuration

Attempting to automatically configure your
e-mail settings.,

Ta skip this step, tap Skip,

Status:

|Eancel || Back || Next

Edit 3 E|A

2. Inbox will then attempt to ascertain your mail server settings by examining the syntax of your e-mail
address.

®

E-mail Setup {3/5)

User information

Your name: |Jack Smith
User name:

Save password
|Eancel || Back || Next I

Edit 3 E|A
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3. If the settings are not correct, enter your name, account user name and account password. Check
Save Password if you want this password to be saved for future connections.

E-mail Setup (4,5} (7]

Account information

Account bype: |IMAP4 -
Marme: |Corporate]

|Eancel || Back || Next I
123|1|2|3|4|5|6|?|B|9|l]|

AN
ctfai] - [\ [4]t
Edit X

4. Next, choose whether this account is POP3 or IMAP4 (IMAP4 should be used for standard IMAP and
Exchange Server accounts). Provide a friendly name for this account.

E-mail Setup {5/5) 0

Server information

Incoming mail: |mail. software, soft
Cukgoing mail: |mail software, soft

| Cancel || Back || Finish I

Edit 3 E|A

5. Inthe final part of the wizard, input your incoming and outgoing mail servers and your domain name if
applicable. Consult your IT department for this information. Pressing Options allows for deeper
customization of your account settings.

Options {1,3) [?]

Mote that connecting automatically may result
in higher connection charges.

Connect and check For messages every:

minute(s)

|Eancel H Back || Next I

Edit 3 E|A

(o))
[6¢]
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You can opt to connect to your server and download new messages on a defined schedule. You
can set whether the Work or The Internet connection profile is to be used. See Chapter 16 for

further details.

Options {2,/3) [?]

Qutgoing e-mail server requires
authentication

Require secure connection
Only display messages From the

last days

|Eancel H Back || Next I

Edit 3 E|A

In the next screen you can choose to have an authentication request for sending outgoing mail,
require a secure connection during all connections, and only display a certain number of days

worth of messages.

Options {3,/3) [?]

Include

Cancel H Back || Finish I

Edit 3 E|A

POP3 account users will see this screen. You can choose whether only message headers
(no message body) should be downloaded, whether a certain number of kilobytes of the
message should be downloaded, or if the entire message should be downloaded.
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o g 244

Options (3/3) [?]

‘Get full copy of messages -|

Include 3

when getting Full copy, get attachments

Cnly if smaller than K

|Eancel || Back || Finish I

Edit E|A

b. IMAP account users will see this screen. In addition to the options above, you can choose
whether or not to download attachments when full message copies are downloaded, and
restrict those attachments to being smaller than a certain size.

Configuring an Inbox Account

Selecting Accounts, Accounts and then tapping on a valid account will present the same wizard screens as
those shown in “Creating a new Inbox Account”.

NOTE: You cannot make setting changes to an account while you are connected to it.

Obtaining Account Status

By selecting Tools, Status from within a valid Inbox account, important status information can be viewed at a
glance.

Status

On nexk connect
Messages to be sent:
Messages to be copied:
Attachments to be copied:
Messages to be deleted:

- o oo

E|A

Status information presented includes the number of messages in your Outbox, the number of messages to

be downloaded when you next connect, the number of attachments to be downloaded, and the number of
messages to be deleted off the server.
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Selecting Tools, Options allows you to modify how messages appear on screen and to define custom

signatures for each account.

Options

‘Wwhen replying, include body
Indent
I:‘ Add leading character:

Keep copy of sent mail in Sent Folder
After deleting or moving a message:
|Sh0w next message v|

Empty deleted items:
|Manually - |

Accounts | Message | Address | Storage |

Vi

In the Messages tab, you can customize reply-formatting options, set your PiN to keep a copy of your sent
mail, and customize how your PiN acts when you delete a message while reading it. Deleted items can be
emptied immediately, on connect/disconnect to an account, or manually.

NOTE: The Deleted Items folder can grow large, so it is important to at the very least manually clear this

folder from time to time.

Signatures

Select an account:

|W0rk -
Use signature with this account

I:‘ Use when replying and Forwarding

Jack Srnith
Yoice: 123-555-3294]

[

<

V4s

Pressing the Signatures... button allows you to write text that will be placed at the bottom of messages sent
through your accounts. Each account can have its own signature.

1. Enter signature text.

2. Go through each account from the Select an account dropdown, and for each account:

i. Choose whether the signature should be used

ii. Indicate whether the signature should be used when replying and forwarding (otherwise, the
signature will appear only when you write new messages)
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Options

In Contacts, get addresses From:

Many mail servers can verify names with an
online address book, Tap the service you
want ko use or tap Add to specify a new one,

Carparate Mail

Accounts | Message | Address | Storage |

Vas

In the Options screen, under the Address tab, you can choose to search a limited number of e-mail fields
with a contact searched. It is recommended that you leave the default “All e-mail fields” activated because
search time tends to be minimal.

With each mail service, you can define an online address book. Highlight the service name then click Add...
to define an OAB.

Online Address Book

Directory name: Server:
|Sthware GAL |ga|.software.soft |

Authentication is necessary
on this server

User name: Passwiord:
jaCk | EEE S 2 |

Check name against this server

Edit E|A

Your IT department should be able to provide you with the information requested by your PiN. When you
have defined an OAB, your PiN will first search your local contacts for a match. If a match is not found, your
PiN will search the defined OAB.
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Main mernory {18335KE free)
Storage card {not installed)
Current size of attachments {132KE)

[ store attachments on storage card

Accounts | Message | Address | Storage |

E|A

PiN 570 | User Manual

Finally, in the Storage tab of Inbox options, you can opt to save message attachments to a storage card.
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Managing E-mail Messages and Folders

By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted
ltems, Drafts, Outbox and Sent Items. The Deleted ltems folder contains messages that have been deleted
on the PiN. The behavior of the Deleted and Sent Items folders depends on the options you have chosen. In
the message list, tap Tools - Options > Message tab, then select your options.

If you want to organize messages into additional folders, tap Tools - Manage Folders to create new
folders.

Folder behavior with a direct connection to an e-mail server

The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3 or IMAP4.

If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be
synchronized with your PiN. You can select to synchronize additional folders by designating them for
ActiveSync. The folders you create and the messages you move will then be mirrored on the server.
For example, if you move two messages from the Inbox folder to a folder named Family, and you have
designated Family for synchronization, the server creates a copy of the Family folder and copies the
messages into that folder. You can then read the messages while away from your desktop computer.

If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the
messages on the PiN and their copies on the mail server. The next time you connect, the mail server
will see that the messages are missing from the PiN Inbox and delete them from the server. This
prevents you from having duplicate copies of a message, but it also means that you will no longer have
access to messages that you move to folders created from anywhere except the PiN.

If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on the
server. Therefore, messages are available to you anytime you connect to your mail server, whether it is
from your PiN or desktop computer. This synchronization of folders occurs whenever you connect to
your mail server, create new folders, or rename/delete folders when connected.
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13. More Programs
Pocket Word

Using Pocket Word, you can create new documents on your PiN, copy documents from your computer to
your PiN, or synchronize documents between your computer and your PiN so that you have the most up-to-

date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. To create a new

file, tap - Programs - Pocket Word - New. A blank document appears unless you have selected a
template for new documents in the Options dialog box. If you have, then that template appears with
appropriate text and formatting you have provided. You can open only one document at a time; when you
open a second document, you will be asked to save the first. You can save documents in a variety of
formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).

Pocket Word contains a list of the files stored on your PiN. Tap a file in the list to open it. To delete, make
copies of, and send files, tap and hold a file in the list. Then, select the appropriate action on the pop-up

menu.

Select the type of folder you
want di splayed in the list

Pocket Word g 5 P 7 °
Name ~| 7.4 t0 change the sort
nwards 1174799 27k order ofthe list.
Cornell Academic ... 10/4/00 35k
Expert Dpinions 12/4/01 22k
9/14/02 21k
2/28/03 46k
Create Copy 10/3/01 20k

Delete 10/8/02  blk
Select All

Tap to open & document.

——Tap and hold an tem to see

Send via E-mail... ]
& pop-up m enu of actions

Beam File...

Rename,/Move...

New Tools E|A

|Tap to create a newdocument

You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and recording),
which are displayed on the View menu. Each mode has its own toolbar, which you can show and hide by
tapping the Show/Hide Toolbar button on the command bar.

NOTE: You can change the zoom magnification by tapping View and then Zoom. Then select the
percentage you want. Select a higher percentage to enter text and a lower one to see more of your

document.

If you're opening a Word document created on a desktop computer, select Wrap to Window on the
View menu so that you can see the entire document.
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Input Modes

Once in a document, the View menu allows you to switch between input modes. You have a choice of
writing, drawing, typing, and recording modes.

Toolbar all
files VD.L v Wrap to Window &3
Seryid
Service|  writing =i
2.1 de Drawing Il'—l'rf
into your * szmg_ o
projects, Recording =Ll
CH-VErS  apo0m [
PR =N = fu
Mew Edit |Yiew|Tools T,

Typing Mode

Tap to return to the
Tap and hold to see & documert list (change s are
pop-up menu of actions. saved autom atically).

Copy

Clear

Format...
Paragraph...

Tap to change
formatting options.

Tap to format texd.

¥ B I Spell Check = |

— iz
1231 [2[3[4[s[6[7[8]9[0]- =]«
Tahl':IIW\EIrItIHUIiIﬂln\‘[

caP[a[s[a[f]a[h]i[k][I];
/
I

shift[ 2 [« [c[v[b[n[m[.[.[/]
cufai[ " [\] W]«
MNew Edit Yiew TDDIs

Tap to showaor hide
the toolbar.
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Writing Mode

With Space button selected,
drag to insert space. 8n amow
sppears showing the space
direction and size.

Z §|. 1] — | Tapto highlight selected text

New Edit Yiew Tool

Tapto z=led formatting options,
such as pen weight and line color,

Space button

Pen button

NOTE: If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can be
edited and manipulated as described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is converted to a
Word document on your desktop computer.

Drawing Mode

Select Shape onthe
POR-UR menu to convert
objects to proper shapes.

Pocket Word o WZ 444 (O

O
S
Q

Resize an object by dragoing
the selection handles.

NEw Edit] Vi E‘A
Tap an amoyw to Tap to select formatting options
see your choices.  |such as line weight, fill color, and line color
Pen hutton
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Recording Mode

In recording mode, embed a recording into your document. Recordings are saved as .wav files and appear
-

as “¥< icons embedded in your document.

Pocket Word

Indicates a new
recording seved

This directory containg all the
files you need to develop ActiveSync
service provider for Windows CE
Services and a Windows CE version
2.1 device (Eg. Handheld PC Pro).

To install, simply capy all files Play previousnext

into your PC. To build these — recording
projects, you need Microsoft |

|.. | ™ | b ‘ U:. ‘"& | |nﬂ§— iﬂdjustvnlume
level

New Edit Miew Tuuls E|‘
Playback recording
Stop recording Recording pragress

Record

Exploring Pocket Word Features

File and Folder Management

The introductory screen to Pocket Word provides a comprehensive list of all viewable documents on your PiN
and allows you to perform file management tasks on those documents.

%5 All Folders
[C Business
(L3 Personal
) Templates

Y add/Delete...

First, selecting “Show” immediately below the Pocket PC title bar allows you to view specific folders within
your My Documents folder. You can add or delete folders by selecting Add/Delete.



Do ywou want to save
changes to license'?

Pocket Word
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If at any time you hit the ok button when a document is open, it will be automatically saved. However, if you
select New, you will instead see the above dialog box.

filg

Se

into

proj

C++
I

New

Undo Zoom
Redo

Cuk

Copy
Paste
Clear
Select All

Format...
Paragraph...
Find/Replace...

Rename;Move...

=ir:

Act]

lofl

Edit|¥iew Tools T,

The Edit menu contains numerous useful selections. Multi-level undo/redo is supported by Pocket Word.

Document Tools

Although Pocket Word is not as feature complete as Microsoft Office Word, it does have a number of
advanced document tools including a spell checker and the ability to send documents to other users.

spell Check
Word Count
Insert Date

Recognize
Alternates...

Beam Document...
Send wia E-mail...

Revert to Saved
Save Document As...
Delete Document

Options...

X

(8
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Recognize and Alternates are for use in Writing mode. For more details on writing recognition see “Writing on
the Screen” on page 31.

Beam Document and Send via E-mail will attempt to beam the document to nearby PiNs and creates a
new outgoing e-mail message with this document attached, respectively.

Revert to saved will remove all changes since the last time the document was saved and restore the last
good copy.

Save Document As will allow you give a new name to the document, change its folder, change its type
(supported types include Pocket Word, Rich Text, Plain Text, Word 97/2000, Word 6.0/95, Word 97/2000
Template). You can also opt to save the document to a storage card.

Delete document allows you to remove the document from memory.

Pocket Excel

Using Pocket Excel, you can create new workbooks on your PiN, copy workbooks from your computer to
your PiN, or synchronize workbooks between your computer and your PiN so that you have the most up-to-
date content in both locations.

To create a new workbook, tap - Programs > Pocket > Excel > New. A blank workbook appears
unless you have set a template for new workbooks in the Options dialog box. If that is the case, then that
template appears with appropriate text and formatting already provided. You can open only one workbook at
a time; when you open a second workbook, you will be asked to save the first.

Select the tyoe of folder you
want displaved inthe list.

sz

Sy AllFolders + Mame =i Tap 1o change the sort
Z]Fall 2002 Schedu... 3/6/02 12k | orderofthelist.
jFaII 2002 Schedu... 8/28/02 12k

TimeSheet1020.. 10/26/02 16k

i 10/6/02 16k —Tapto open a document.
ate Cop
Delete
select all

Send via E-mail...
——Tap and hold an tem to see

Beam File... !
- & pop-up menu of actions .

Rename;/Move...

New Tools E|A

|Tap to create a nevwdocumert.

The document list view in Pocket Excel parallels that of Pocket Word.

File and Folder Management

The introductory screen to Pocket Excel provides a comprehensive list of all viewable workbooks on your PiN
and allows you to perform file management tasks on those workbooks.
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%S All Folders
[C1 Business
i My Pictures
[CZ Personal
= Templates

CH add/Delete...

First, selecting “Show” immediately below the Pocket PC title bar allows you to view specific folders within
your My Documents folder. You can add or delete folders by selecting Add/Delete.

You can sort the available workbooks by name, date of modification, size of file, or type.

Tap-and-holding on any file allows you to create an exact copy of the workbook (in the source’s directory),
delete the workbook, select all viewable workbooks, send workbooks via e-mail, beam a file to another
computer or PiN, rename a file or move a file.

Tools > Options allows you to specify the default document template, where to save the document (main
memory or a storage card), and what file types should appear in the file list display.

If at any time you hit the ok button when a workbook is open, it will be automatically saved as in Word.
However, if you select New, you will instead be asked if you wish to save the open workbook.

5™ Undo Typing in H3
I—H Can'tRedo 1
L1 1 L
2 Cuk

3 Copy

a Paske

5 Paste Special...

6 Clear »
L¥ || selectaAll

8
—H ...

|| —MM
11| Find/Replace...
112 ||  Password..
4] —— [
Read Rename,/Move.. 78
New Edit| ¥iew Format Tools

The Edit menu contains numerous useful selections. Multi-level undo/redo is supported by Pocket Excel.

Microsoft Reader

Use Microsoft Reader to read eBooks on your PiN. Download books to your computer from your favorite
eBook web site. Then, use ActiveSync to copy the book files to your PiN. The books appear in the Reader
Library, where you can tap them in the list to open them.

Each book consists of a cover page, an optional table of contents and the pages of the book. You can:

. Page through the book by using the Up/Down toggle on your PiN or by tapping the page number on
each page.
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. Annotate the book with highlighting, bookmarks, notes, and drawings.

. Search for text and look up definitions for words.

The Guidebook contains all the information you will need to use the software. To open the Guidebook, tap

Help on the Reader command bar. Alternatively, on an eBook page, tap and hold the book title, and then tap
Help on the pop-up menu.

To switch to Microsoft Reader, tap - Programs > Microsoft Reader.

Getting Books on Your PiN

You can download book files from the Web. Just visit your favorite eBook retailer and follow the instructions
to download the book files.

Sample books and a dictionary are included in the MSReader folder in the Extras folder on the Pocket PC
Companion CD.

Use ActiveSync to download the files from your desktop computer to your PiN as described in the Read Me
file in the MSReader folder.

Using the Library

The Library is your Reader home page; it displays a list of all books stored on your PiN or storage card.
To open the Library:

. On the Reader command bar, tap Library.

. On an eBook page, tap the book title, and then tap Library on the pop-up menu.

To open an eBook, tap its title in the Library list.

Pace 1 Tap to scroll through
the Library list.

Library

Tap to select
a sot order.
The Best American Short Stories

The Ghost Writer
The Hundred Secret Senses  ———Tap to open & book.
v{gmﬂﬂ‘%,ﬂ; Outlander
inthe list. Suger Plum Dead
Another World
‘Winter of the Wolf Moon
The Last Precinct

Tap to spectfy

Cn Writing
Tap hereto Etsbenle- Sl Fassage to Juneau
mﬁ::;agaarttg toof Of Love and Other Demons

the Reader. Return Stranger in a Strange Land

Reading an eBook

Each book consists of a cover page, an optional table of contents and the pages of the book. Navigation
options are listed in the bottom portion of the cover page.
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The first time you open an eBook, you will probably want to go to the first page or to the table of contents, if
one exists. Subsequently, upon opening the book, you will automatically be taken to the last page read.

When you open the eBook for the first time, you will see the book’s title image, if it has one. The first page of
the book will then display.

Each book page includes a page number and the book title.

|~ The Call of the Wild
Tap to select

& navigation were booming the find, thousands

option. of men ﬁﬁhm—mto_fhe_ﬁ
Morthland. Th{ add Bookmark +— Dragto select text and
dogs, and the Add Highlight thentap an option.
were heavy d RN
ruscles by whi -
coats to prote| Add Drawing
frost. Find...

Buck lived | Copy Text
the sun-kissed Sama cara vaney:
Judge Miller's place, it was called.
It stood back from the road, half
hidden among the trees, through
which glimpses could be caught
of the wide cool veranda that ran

45 p————— 1 Taparrowsto turn
the page, or tap and
hold page # to bring
up page rife .

You can page through an eBook by using the Up/Down toggle on your PiN.

Microsoft Reader

> 20000 Leagues Under The Seag
Cover Page d
Table of Contents fl2@n

Annotations e
Help

Library
Settings
Return

Clicking the navigation drop-down (circled in black) allows you to view the cover page, table of contents, and
list of annotations (this includes highlights, bookmarks, drawings, and text notes). You can also use this menu
to access help, go back to the book library, change settings, and return to the previous screen.

Navigating an eBook

Navigating an eBook is typically done with the use of the Up/Down Toggle or the stylus, but you can also
search for specific words in an eBook.
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UTE SLIMTUTATTY SULTETES 4T

q making

Find First

Find Previous = Find Mext

f

] .

i1~ Using exact match
W

Using approximate match
fiUsing exact match

1sroar A inlr cond coree A F

Tap and hold anywhere within the text of an eBook and select Find... to see this dialog box. Enter the
desired search text at the top, then select Find First, Find Previous, or Find Next. You can search with an
approximate or exact match.

o

R Table of Contents
Most recent page

[ai)

Beqgin reading
Furthest read

Annotations
About this title

Library Cover Image

You can also use the Go to menu, which allows you to jump to one of several important places within an
eBook. Select this from the Library view with the desired book highlighted.

Marking up an eBook

With support for bookmarks, highlighting, text notes, and drawings, you can mark up your eBook as if it were

paper.
IMas. DT
ble

naf Add Bookmark
tiel Add Highlight
Nal Add Text Note
it, Add Drawing
@ Find ...

WG
od Copy Text

A bookmark allows you to denote a special place in an eBook worthwhile for future reference. Click on the
text on a page of interest, and select Add Bookmark.
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+ 20000 Leagues Under The Seas

went from sea serpents to
the most offensive per-
sonal remarks.
For six months the war
seesawed. With inexhaust-
ible zest, the popular press
took potshots at feature
articles from the Geo-
graphic Institute of Brazil,
the Royal Academy of Sdi-
ence in Berlin, the British
Association, the Smithso-
4 27 )

A bookmark has been added, as indicated by the little arrow.
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Tapping on the bookmark then selecting Change Color allows you to change the look of the bookmark.

Tapping on the bookmark then selecting Delete will remove the bookmark.

Tap on a page’s text and select Add Notes to be presented with the following edit box.

Microsoft Reader oz 332 9

+ 20000 Leagues Under The Seas

the scholarly societies and
scientific journals. The
"monster question" in-
flamed all minds. During
this memorable campaign,
journalists making a pro-
fession of science battled
with those making a pro-
fession of wit, spilling
waves of ink and some of
them even two or three
drops of blood, since they
4 26 »

Tap outside the edit box, and the note is added to that page. Tap on the icon to edit the text.

To draw on the screen, tap anywhere on the text and select Add Drawing. Make scribbles as needed.
To undo a previous step, select Undo.

Selecting Copy Text after highlighting one or more words allows you to paste the highlighted contents into
any Pocket PC application that supports the Paste function.

Removing an eBook

When you finish reading an eBook, you can delete it to conserve space on your PiN. If a copy of the book is

stored on your desktop computer, you can download it again at any time.
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Microsoft® Reader Help

Delste

Maost recent page
About this title

To remove an eBook from your PiN, tap and hold the title in the Library list, and then tap Delete on the pop-
up menu.
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14. Software Accessories

The Software Accessories consist of Microsoft MSN® Messenger, Microsoft Windows Media Player 9 Series,
Microsoft Terminal Services, Microsoft Games and Pictures.

MSN Messenger

MSN Messenger is an instant messaging program that lets you:

. See if your contacts are online.

. Send and receive instant messages.

. Have instant message conversations with groups of contacts.

To use MSN Messenger, you must have a Microsoft Passport™ account or a Microsoft Exchange e-mail
account. You must have a Passport to use MSN Messenger Service. If you have a Hotmail® or MSN account,
you already have a Passport. Once you have obtained either a Microsoft Passport or a Microsoft Exchange
account, you are ready to set up your account.

NOTE: Sign up for a Microsoft Passport account at http://www.passport.com. Get a free Microsoft
Hotmail e-mail address at http://www.hotmail.com.

To switch to MSN Messenger, tap & - Programs > MSN Messenger.

Setting Up
Before you can connect, you must enter Passport or Exchange account information.

To set up an account and sign in:

1. Launch MSN Messenger. Ensure you are connected to the Internet (see Chapter 16 for details on how
to get connected).

I[MSN Messenger o < 2:50 °

Tap here to sign in

msn*

Messenger Service

Tools Chats & |A

2. Select Tools, Options and select the Accounts tab.
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MSN Messenger o g3

Accounts

Enable MSN Messenger Service
Sign inname: | jack@dormain,com

Passward: sk oh sk ok sk ok o

I:‘ Enable Exchange Instant Messaging
Sign in name:

Password:

Sign in using this account first
@ M5M Messenger Service

O Exchange Instant Messaging

General | Privacy | Accounts |

2]

3. In the Accounts tab, enter your Passport or Exchange account information. Be sure to indicate which
service you wish to connect with.

4. To sign in, tap the sign-in screen and enter your e-mail address and password.

NOTE: If you already use MSN Messenger on your computer, your contacts will appear on your PiN
without being added again.

In future connections, your information will be already entered in the screen following Tap here to sign in.

Working with Contacts

The MSN Messenger window shows all of your messenger contacts at a glance, divided into Online and Not
Online categories. From this view, while connected, you can chat, send an e-mail, block the contact from
chatting with you, or delete contacts from your list using the pop-up menu.

MSN Messenger

_i Kim aAkers {Online)
‘i Online

‘i Adarn Barr

‘i Jo

g& Fandall {Away)
‘1 Not Online

& Richard Bready

‘1 David Hodgson

———Tap a contact to statt & chat.

Send Mail (Tim@woodgrovebank.c...

Block ————Tap and hold to display
Delete Contact a pop-up menu of actions.
Properties

Tools E“

NOTE: To see others online without being seen, in the Tools menu, tap My Status and select Appear
Offline.

If you block a contact, you will remain on the blocked contact’s list, but willl always appear to be offline to
them. To unblock a contact, tap and hold the contact, then tap Unblock on the pop-up menu.
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Chatting with Contacts

Tap a contact name to open a chat window. Enter your message in the text entry area at the bottom of the
screen, or tap My Text to enter a preset message, and tap Send. To invite another contact to a multi-user
chat, in the Tools menu, tap Invite and tap the contact you want to invite.

NOTE: To switch back to the main window without closing a chat, tap .-i To revert back to your chat
window, tap Chats and select the person with whom you were chatting.

Pressing My Text allows you to send commonly-used expressions to your contacts. Select Tools—Edit My
Text Messages to edit the text.

To know if the contact with whom you are chatting is responding, look for the message under the text entry
area.

If the other chat participants are not entering text, you will see at the bottom of the screen the date and time
of last message received by those participants.

3, —harles Pickrell

Sign In...

Sign Dut
NN Busy
Add a Contact| Be Right Back
Edit My Text M Away

- 0On The Phone
Options... Out To Lunch | * |

Tools| Chats Appear Offline =]

To change how you appear to other users, from either the main Messenger window or a chat window, select
Tools, My Status. These choices appear in MSN Messenger.

Windows Media Player for Pocket PC

Use Microsoft Windows Media Player for Pocket PC to play digital audio and video files that are stored on
your PiN or on a network.

To switch to Windows Media Player for Pocket PC, tap - Programs - Windows Media.

Wielcome To Windows Media-& - | Ful-screen mode

Py

Iy
Windows
Media Player

Indicates the progress
ofthe current track

(DD OV @ —0=—

Tap to adjust volume:

Playlist Tools £|A

Mute sounc

Stop Previousinest
Taptoplay  sslection
or pauss
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Media Playback

Once a media file has been loaded, you can play, pause, stop, song advance/reverse, mute sound or adjust

volume. During playback, tap the full-screen mode icon to hide the toolbar and show the media in
landscape mode. Note the media file name is located to the left of the full-screen mode button.

Tools Functions

Settings

Properties
Open URL

Add Web Favorite

Repeat

The tools menu allows you to perform several important functions.

About gives you information about the codecs used in your version of Windows Media Player.

Settings changes a variety of program settings.

Properties gives a detailed listing of a media file’s attributes.

Open URL allows you to open WMP-compliant media from a network or Internet resource.

Add Web Favorite adds a streaming media file that is currently playing web favorites.

Repeat plays a playlist repeatedly.

Shuffle plays items in a playlist in a random order.

Using the Terminal Services Client (TSC), you can log onto a desktop computer running Terminal Services

(pre-Windows XP) or Remote Desktop (Windows XP and later) and use all of the programs available on that
computer from your PiN.

shs2k - Terminal Servic #(£ 9:13 &9
B~
User name: I administrator
Password: I bk
Log on ko ISBSDOM

[ il I
123|1|2\3|4|5\6|7|B\9|0| =]«
Tab[a[wler[t]y[uli[o]p[L]]
caP[a[s[d[f]a[n[i]k]1[;

=|—— Remote desktop session

[
Shift[z [% [ [¥]b]n[m], ] |f\
cuaa] - TA ] Lt ]<]~>
1 &l (5] [ [E =R

Directional buttons
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NOTE: Transcriber is not supported as an input method during a Terminal Services session. You must
use Keyboard, Block Recognizer, or Letter Recognizer.

Connecting and Using TSC

Before attempting a Terminal Services connection, you must have authorized access to a desktop or server
that supports this service.

1. Launch TSC

Terminal Services Clien 4% 5:48 e

Server:
192.168.0 |

Recent servers:

Lirnit: size: of server desktop to fit
on this screen

E|‘

2. Enter the IP address or host name of a valid TS server. Checking Limit size of server... attempts to
compress the remote desktop screen to minimize scrolling. Press Connect to start connection.

3. Typically you will be asked to login.

192.168.0.16 - Termina (% 5:51 €9

Flle Edit wview Favories | 4
{2 Back ¥ = ¥ | @Search ?
Address |g =0 d o
T ™ oo Here
C’ E Top q
TEMP kra
Page Un

r\—l [_\' Page Dowh
e oo me I oo Up

{jStartlEmd Scroll Dawn
=[]

If the desktop server is not in optimized mode, you can tap and hold on the screen to see available options in
a context menu.
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3 |192.168.0.16 -

&/start|

Termina =% 5:49 °

Jurik.
s XP Server

’1,1_31, 4:02 PM

=18

5. Use the remote server as if you were using it directly.

Pictures

Use Pictures to view JPEG pictures stored on your PiN or in a storage card, send pictures to others, view a
slideshow of your pictures, or set a picture as the background on the Today screen. You can even set
Pictures to launch itself when a digital camera storage card is inserted into your PiN!

Lacation chaoser

ictures

Storage Card ~

Sart by

5

“£304 €3

Date v

MG _0661 TMG_0660

o .

Image
thumbnal

IMG_0659

Create Copy
Delete
Select All

Tap and hold

078 Surnmerfics 0421 Image

file name:

Send via E-mail...

Beam Picture...

reeme |

SummerPics 019 SummerPics 010 SummerPics 111

K

Tools T | ?

Main memory

B

‘ Storage card

Wiew slideshow

To begin, run Pictures and either choose to view main memory or storage card contents. By tapping and
holding on an image, you can create a clone of that file, delete that file, select all files, send file via e-mail,
beam picture or rename the image.
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Storage Card Date «
MG _0BE] TMG_0EED TMG_DEES PN
+Pics 086 HPics 078 Hics 042

ol

SurimnerPics 019 SurnmetPics 010 | STEETeEe|
123y ! 2@|3""4$ 6" [7%(g"|a |0 -
Th{q|wle|r|t]|y u|i||:||p|:+
aiifa[s[a[f]a][n]i]k]I
ct[\[z]x[c[v[b][n[m][<

Tools TJ |

e

_>|,J?

If you choose to Rename, type in the new file name.
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15. Pocket Internet Explorer

Use Microsoft Pocket Internet Explorer to view Web or WAP pages in either of these ways:

. Connect to an Internet service provider (ISP) or network and browse the Web. To do this, you will need
to create the connection first, as described in Chapter 16.

. During synchronization with your desktop computer, download your favorite links and mobile favorites
that are stored in the Mobile Favorites subfolder in Internet Explorer on the desktop computer.

When connected to an ISP or network, you can also download files and programs from the Internet or
intranet.

To switch to Pocket Internet Explorer, tap - Internet Explorer.

The Mobile Favorites Folder

Only items stored in your desktop computer’s Mobile Favorites subfolder (located in Internet Explorer’s
Favorites folder) will be synchronized with your PiN. The Mobile Favorites folder was created automatically
when you installed ActiveSync.

Favorite Links

During synchronization, the list of favorite links in your desktop computer’s Mobile Favorites folder is
synchronized with Pocket Internet Explorer on your PiN. Both computers are updated with changes made to
either list each time you synchronize. Unless you mark the favorite link as a mobile favorite, only the link will
be downloaded to your PiN, and you will need to connect to your ISP or network to view the content.

Mobile Favorites

If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can download mobile
favorites to your PiN. Synchronizing mobile favorites downloads Web content to your PiN so that you can
view pages while you are disconnected from your ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites quickly.

To create a mobile favorite:
1. InInternet Explorer on your desktop computer, click Tools > Create Mobile Favorite.
. To change the link name, enter a new name in the Name box.
. To change the update frequency of mobile favorites, in Update select a desired update schedule.
2. Click OK. Internet Explorer downloads the latest version of the page to your desktop computer.
3. If you want to download the pages that are linked to the mobile favorite you just created, in Internet
Explorer on the desktop computer, right-click the mobile favorite and then click Properties. In the

Download tab, specify the number of links deep you want to download. To conserve PiN memory, go
only one level down.
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4. Synchronize your PiN and desktop computer. Mobile favorites that are stored in the Mobile Favorites
folder in Internet Explorer are downloaded to your PiN.

NOTE: If you did not specify an update schedule in step 3, you will need to manually download content to
keep the information updated on your desktop computer and PiN. Before synchronizing with your PiN, in
Internet Explorer on your desktop computer, click Tools - Synchronize. You will see the last time
content was downloaded to the desktop computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet Explorer on
your desktop computer, click View - Toolbars - Customize.

To save PiN memory

Mobile favorites take up storage memory on your PiN. To minimize the amount of memory used:

. In the settings for the Favorites information type in ActiveSync options, turn off pictures and sounds, or
stop some mobile favorites from being downloaded to the PiN. For more information, see ActiveSync
Help.

. Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer, right-click
the mobile favorite you want to change, then click Properties. In the Download tab, specify O or 1 for
the number of linked pages you want to download.

Using AvantGo Channels

AvantGo is a free interactive service that gives you access to personalized content and thousands of popular
websites. You subscribe to AvantGo channels directly from your PiN. Then, you synchronize your PiN and
desktop computer, or connect to the Internet to download the content. For more information, visit the
AvantGo Web site.
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16. Getting Connected

You can use your PiN to exchange information with other PiNs as well as your desktop computer, a network,
or the Internet. You have the following connection options:

. Connect to your Internet service provider (ISP). Once connected, you can send and receive e-mail
messages by using Inbox and view Web or WAP pages by using Microsoft® Pocket Internet Explorer.
The communication software for creating an ISP connection is already installed on your PiN. Your
service provider will provide software needed to install other services, such as paging and fax services.
If this is the method you want to use, see “Connect to an Internet Service Provider” later in this chapter.

. Connect to the network at your company or organization where you work. Once connected, you can
send and receive e-mail messages by using Inbox, view Web or WAP pages by using Pocket Internet
Explorer, and synchronize with your desktop computer. If this is the method you want to use, see
“Connect to Work” later in this chapter.

. Connect to your desktop computer to synchronize remotely. Once connected, you can synchronize

information such as your Pocket Outlook information. If this is the method you want to use, see the
sections detailing ActiveSync above.

Connect to the Internet

You can connect to your ISP, and use the connection to send and receive e-mail messages and view Web or
WAP pages.

You can connect to work in one of two ways:

. Create a modem connection. If this is the method you want to use, see “To create a modem
connection to an ISP.”

. Use an Ethernet card and a net tap to connect to the network. If this is the method you want to use,
see “To create an Ethernet connection to an ISP.”

Visual Connectivity Cues

Your connectivity status is made clear by one of ten icons shown in the notification area. Note that some of
these icons are animated.

*
q.l.l. Connected
n
—* or il Transferring Data
e
Ll Not connected
t:"' Synchronizing
Ii:l Zero-Configuration Internet
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Creating a modem connection to an ISP

1.

4.

5.

6.

Obtain the following information from your ISP: ISP dial-up access telephone number, user name,
password and TCP/IP settings. Some ISPs require information in front of the user name, such as
MSN/username.

Install a modem card, or use a NULL modem cable and appropriate adapters to connect an external
modem to your PiN through the serial port.

Tap - Settings > Connections tab - Connections icon !Ea
The Connections screen will display.

o df 1249

Connections 9

Ta set up ar change connection information,
tap one of the Fallawing links.

My ISP
#Add & new modem connection

My Work Network

#Add & new modem connection
Add & new YPM server connection
Set up iy prosy server

Tasks | Advanced |

E|A

Tap Add a new modem connection under the My ISP heading from the Connections screen.

Make New Connection e

Enter a name For the conneckion:

My Connection |

Select a modem:

Cancel || Back || Next |

Vs

Enter a name for the connection, such as “My Connection.”

In the Select a modem list, select your modem type. If your modem type does not appear, try re-
inserting the modem card. If you are using an external modem that is connected to your PiN with a
cable, select Hayes Compatible on COM1.
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My Connection e

Enter the number exactly as it should be
dialed. Include any extra numbers, such as
an outside line o credit card,

[123-555-4854 |

IF wou kravel or change area codes often,
use disling rules.

| Cancel || Back || Next |

Vs

7. Now enter the number that should be dialed when connecting to your ISP. Include any special digits
such as “*” or “#”. We will explore dialing rules below.

My Connection

User name: jacksm

Domain:*

* If provided by ISP or network administrator,

Cancel || Back || Finish |

Vs

8. Now enter any authentication information your ISP requests.

9. You should not need to change any settings in Advanced. Most ISPs now use a dynamically assigned
address.

Advanced

Baud rate: 19200 -

Wait for dial tone before dialing

Wait For credit card EI seC.

Extra dial-string modem commands:
(iEE ] |
Cancel if not connected in seC.

General | Port Settings | TCRIIP | Servers |

Vs
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To change the connection speed of your connection, wait for dial tone before dialing, wait for
credit card, add dial-string modem commands, or cancel call after a set number of seconds, use

the General tab.

Advanced

Connection preferences

Data bits:

Parity:

Stop bits:

Flow contral:
Terminal

[ use terminal before connecting
[ use terminal after connecting

I:‘ Enter dialing commands manually

General | Port Settings | TCPJIP | Servers

Vs

The Port Settings tab has options that should be left alone, u

nless your ISP indicates otherwise.

Advanced

() Use server-assigned IP address
() Use specific IP address

152, 2 .33 . 2

[ use slip
Use software compression
Use IP header compression

General | Port Settings | TCRIIP | Servers |

Vs

If the ISP you are connecting to does not use a dynamically assigned address, enter that
information into the TCP/IP tab.

Advanced

() Use server-assigned addresses
() Use specific server address

DN3: (152,123, 5 . 22

kDM { o .0 .0 . 0O
WING 152,193,255, 5
AbWINS: [ o oo .0 .0

General | Port Settings | TCRIIP | Servers

Vs
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iv.  Finally, if your ISP requires special DNS or WINS information, enter it into the Servers tab.

10. Tap Finish to complete this wizard.

Connecting to your ISP:
1. Open the Connections screen.

2. Tap Manage Existing Connections

My ISP (2]

Ta creake a connection, tap New, Tap and
hald on an existing connection For more

options.
arme | Mumber
@My ISP Co DEIETE -657-8576

General | Moderm |

=18

3. Tap and hold on the applicable dial-up settings and select Connect. You can delete the connection by
selecting Delete.

4, Your modem will dial out and attempt to create the connection.

Creating a modem connection to your work:

Follow the above instructions, but, under My Work Network, select Add a new modem connection to
begin.

Establishing exceptions for work URLs:

Some companies use periods in their intranet URLs (for example, intranet.companyname.com). If you
attempt to connect to one of these URLs, Pocket Internet Explorer will search for the website on the Internet
rather than on the company’s intranet. To connect to such intranet URLs, they must be entered as Work
URL exceptions.

To add a new exception, from the Connections screen, tap Advanced tab - Select Networks 2>
Exceptions... > Add new URL....
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If wour company uses periods (.} in intranet
addresses, enter the URLs here so you can
connect ko those sites.

URL exceptions:

softwareco.org

Vs

Simply enter a text string following the example and hit ok.

Setting up a proxy server connection for work connections:

PiN 570 | User Manual

If you are connected to your ISP or private network during synchronization, your PiN should download proper
proxy settings during synchronization from your PC. If these settings are not on your PC or need to be
changed, ask your ISP or network administrator for the proxy server name, server type, port, type of Socks
protocol used, and your user name and password.

My Work Network e

This netwark connects to the Internet

This network uses a proxy server to
connect ko the Internet

Prowxy server:
[192.120.0.15¢] |

General | Modem | YPM | Proxy Settings

Vs

1. To create a new connection, under the My Work Network heading, tap Add a new proxy server.

2. Select This network connects to the Internet and This network uses a proxy server...

3. In the Proxy server box, enter the proxy server name.
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My Work Network 0

Server Fort

Secure WAF l:l: 2203
Sacks 192.7.125.9 :| 1020

Type:@SUcks4OSUck55
= 2@3““‘4$ 56" [7%(s"]a (o[-
Tb|lg|w|e|r|t|y|uli|o|p|F
atifa[s[a[fJa][ni[k]1[7]."
ci[\[z[x]c[v][b][n[m].<].>[;?

For advanced options, select the Advanced... button from the Proxy Settings tab. This information
should be given to you by your company’s network administrator.

4. To change existing settings, under My Work Network, tap Manage existing connections and access
the Proxy tab.

Setting up a VPN connection for work connections:

A VPN connection helps you securely connect to servers, such as a corporate network, via the Internet. Ask
your network administrator for your user name, password, domain name, TCP/IP settings, and host name or
IP address of the VPN server.

Make New Connection e

Mame: My VPR

WP bype: () IPSec/L2TP
() PPTP
Cancel || Back || Next |

Vs

1. To create a new VPN server connection, under the My Work Network heading, tap Add a new VPN
server connection.

2. Enter the requested information including VPN type.
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3.

4.

Next either indicate whether a preinstalled certificate should be used or rather a preshared key.

Next enter your login details.

My YPN (7]

Authenticate IPSecfLZTP connections Using:
@ A certificate on this device
O A pre-shared key

| Cancel || Back || Next |

Vs

My YPN (7]

User name: jacksm

* If provided by ISP or network administrator,

Cancel || Back || Finish |

Vs

Advanced

@ Use server-assigned IP address
() Use specific IP address

[ use slip
Use software compression
] use 1P header compression

TCRIIP | Servers |

Vs

Enter TCP/IP settings in the first tab.

PiN 570 | User Manual

Press Advanced... to access more options.
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Advanced

@ Use server-assigned addresses
() Use specific server address

] E—
awus [

TCRIIP | Servers |

2|
ii. Enter Server DNS/WINS information in the second tab.
Connecting to a VPN server:
From the Connections main window, select Edit My VPN Servers.
My Work Network e

To create a connection, tap Mew, Tap and
hold on an existing connection for more
options,

MNarme | Server

Wy VPN ce oy,
Delete

General | Modem | VPN | Proxy Settings |
=

Tap and hold on your server and tap-and-hold then select Connect. Note that through this screen you can
delete your VPN server connection.

Connecting...

Connecking to: My WP

Connecting to ypn.company.vypn ...

Your VPN Server will be accessed.
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When connected, tapping on the ¥

Connectivity

The Internet Metwork Card
My ¥YPN Conneck YR

Settings Hide

g

Establishing dialing rules for your modem connection

1.

2.

Press Select Location from the Advanced tab in Connection Settings.

Connections

®

Metworks are groups of settings used by
programs to automatically connect o an ISP

or private network,
Select Networks

Dialing rules determine how a number is dialed

from a specific location,
Select Location

Select what your network card connects to,

Network Card

Tasks | Advanced |

Vs

Dialing Locations

®

Based on your location, dialing rules determine
how a number is disled and the best number
to use if mare than one exists,

Use dialing rules

Select where yvou are dialing from:

(Home
®work

Vs
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icon in the notification area will show you the above bubble.

Select Enable dialing rules. By default two dialing rules profiles exist: Home and Work. You can
define your own by pressing New... Press Edit to configure either profile.
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't— In order for dialing rules to
wirk properly you rmust

1 verify that all modern

connections have been

configured with the

correct countryfregion and

area codes,

Vs

3. You will be warned that your existing modem connections must include the correct country and region
area code settings. After confirming this, press OK.

Work

@

Mame: |W0rk

Country code

Area code:
Disable call waiting: *70, -
I:‘ Pulse dialing
Dialing Patterns...
Edit s

4. Modify the above values. Press Dialing Patterns... to change how dialing occurs.

Dialing Patterns e

For local calls, dial:

For long distance calls, dial:
[5,1rG |
For international calls, dial:
[o,011EFG |

(E,e = country code; F,f = area code; G,g=
number)

Edit s

5. Following the format of “e” represents country code, “f” represents area code, and “g” represents the
number, enter how local, long distance, and international calls should be dialed. Press ok to save your
changes.
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Initiating 2 modem connection

To start the connection, simply start using one of the following programs. Your PiN will automatically begin
connecting. Once connected, you can:

Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need to provide the
information it needs to communicate with the e-mail server.

Visit Web and WAP pages by using Pocket Internet Explorer.

Send and receive instant messages with MSN Messenger.

Creating a wired Ethernet connection to an ISP or your work

1.

You do not need to create a new connection on your PiN. Instead, you must purchase and configure
an Ethernet card that is compatible with your PiN.

Insert the Ethernet card into your PiN. For instructions on inserting and using the Ethernet card, see the
owner’s manual for the card.

The first time you insert the card, a notification bubble will appear, asking you whether the installed
network card should be used to connect to The Internet or Work. After making that choice, you can
either accept all default settings by pressing OK (most home networks will allow you to immediately get
online without further configuration) or press Settings to configure the connection.

Connections

®

Metwarks are groups of settings used by
programs to automatically connect o an ISP

or private network,
Select Networks

Dialing rules determine how a number is dialed
from a specific location,
Select Location

Select what your network card connects to,

Network Card

Tasks | Advanced |

3

A

i Select the Advanced tab from the Connections Settings.

ii. Select the Network Card tab to customize how each of your installed network card drivers
connects.
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j‘ Settings

Configure Network Adapters

My network card connects ta:
‘Wark -|

Tap an adapter to modify settings:
NEZ000 Compatible Ethernet Driver
L2TP MNDISWAN Miniport

AgyncMac MDISWAN Miniport

FPTP MDISWAMN Miniport

Bluetooth PAN User Driver

Wireless | Metwork Adapters

E|‘

Highlight the driver name of the card you wish to configure

iv.  Indicate whether My network card connects to: either The Internet or Work.

L2TP NDISWAN Miniport

@ s server-assigned IP address
{3 Use specific I address

1P address: |Not connected

IP Address | Mame Servers
123)s %548

Thjq|w|e|r
él'.'||a|s‘|:l‘f‘
Ctl|\||z|x|c|

V. Tap on the name of the driver to receive advanced options.
vi.  Configure the IP address settings in the IP Address tab.

LZTP NDISWAN Miniport

Mame server addresses may be automatically
assigned if DHCP is enabled on this adapter,

we[ ]
v
IP Address | Mame Servers
123, '[9 7], % 8|
Tb(qg w|e r i
éﬂ|a|s d‘f‘g‘h
ey [=]c]

vii.  Configure the DNS and WINS settings in the Name Servers tab.

98



PiN 570 | User Manual
NOTE: You must remove then reinsert your network card for these settings to take effect.
4, Connect the Ethernet card to the network by using a network cable. For information, see your owner's
manual.
n
5. Tap the #" icon in the notification area to see network status.

To start the connection, simply start using one of the programs listed in the preceding section. Once
connected, you can perform the same activities as listed in the preceding section.

NOTE: Once your network card has been configured, you will immediately be connected.

Creating a wireless Ethernet connection to an ISP or your work

1. You do not need to create a new connection on your PiN. Instead, you must purchase and configure
an Ethemnet card that is compatible with your PiN.

2. Insert the wireless Ethernet card into your PiN. For instructions on inserting and using the Ethernet
card, see the owner’s manual for the card.

3. The first time you insert the card, a notification bubble will appear, asking you whether the installed
network card should be used to connect to The Internet or Work. Where possible, the Service Set
|dentifier (SSID) will be determined automatically. After making that choice, you can either accept all
default settings by pressing OK (most home networks will allow you to immediately get online without
further configuration) or press Settings to configure the connection.

4. Sometimes a network will require a WEP key. If so, you will be prompted for one at this point.

Connections

®

Metworks are groups of settings used by
programs to automatically connect o an ISP

or private network,
Select Networks

Dialing rules determine how a number is dialed
from a specific location,
Select Location

Select what your network card connects to,

Network Card

Tasks | Advanced |

3

A

Select the Advanced tab from the Connections Settings.

ii. Select the Network Card tab to customize how each of your installed network card drivers
connects.
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’ Settings

Configure Network Adapters

My network card connects ta:
‘Wark -|

Tap an adapter to modify settings:
Socket LP WLAN 802,11k

MWE2000 Compatible Ethernet Driver
L2TP MDISWAN Miniport

AsyncMac NDISWAN Miniport

PPTP NOISWAN Miniport

Blugtooth PAN User Driver

Wireless | Metwork Adapters

E|‘

Highlight the driver name of the card you wish to configure. Indicate whether My network card

connects to: either The Internet or Work. Tap on the name of the driver to receive advanced
options.

o2 11:00

LZTP NDISWAN Miniport

() Use server-assigned IP address

) Use speific [P address

1P address: [Not connected

TP Address | Mame Servers
23], ']

iv.  Configure the IP address settings in the IP Address tab.

L2TP NDISWAN Miniport

Mame server addresses may be automatically
assigned if DHCP is enabled on this adapter.

s
e
arwis ]
IP Address | Mame Servers
122y ' | 2% 5%]4% |6 785 "0 (o]
Thqw|ertyuiop+
aiifa[s[a[f[a][h[i[k]I]
c[\[z]x]c]v <37

n[m]

V. Configure the DNS and WINS settings in the Name Servers tab.
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NOTE: You must remove then reinsert your network card for these settings to take effect.

5.

Select the Network Card button from Connection Settings—Advanced to configure your wireless

networks.

Configure Wireless Networks

‘Wireless networks:

Add Mew Settings...
§ jrodjrod Cannected
1 link Available

Metworks b0 access:
[0 awailable -

D Automatically connect to non-preferred
netwiorks

Wireless | Metwork Adapters

E|‘

i Networks that you have already configured are preferred networks and are listed in the Wireless
tab. You can select to connect to only preferred networks or have your PiN search for and
connect to any available network whether it is preferred or not. Press Add New Settings... if
you do not see a network you'd like to connect to.

Configure Wireless Network

Metwork name: |jroclirod

If this network cannects to work via a YPN,
select The Internet,

D This is a device-to-computer {ad-hoc)
conneckion

General [ Authentication

E|‘

101

In the General tab you can set the network name (also known as SSID); this is only editable if
you are creating a new wireless network profile else you are viewing a preferred network and
the SSID has already been established. Indicate whether this network will connect you to The
Internet or Work. Finally, if this is a new network profile, you can indicate whether this is a
device-to-computer network.

To determine if authentication is needed, see your network administrator. To use data
encryption, check the first checkbox. To use shared key authentication, check the second
checkbox. To automatically use a network key, tap The Key is provided for me
automatically; else, enter that key. For enhanced security, enable 802.11X network access
and choose among the available EAP types.
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Exchanging Data with other Mobile Devices
PIN Pocket PCs can access local or corporate networks and can also exchange data with other mobile

devices, such as Pocket PCs, Handheld PCs, and Smartphones. Using Infrared or Bluetooth “Beam”, you
can send your contact files, appointments, notes, and many other file types to these devices with great ease.

[ Motel pwi
To beam, select a device.
A, Infrared Align parts
Q, Searching
=-

One example is the Notes application. These instruction steps apply to Calendar, Contacts, Tasks, File
Explorer, Pocket Word and Pocket Excel.

From the Tools menu, select Beam Note. Immediately, your PiN will seek an available Infrared port on a
nearby mobile device. Make sure the IR ports are properly aligned, with no objects blocking the path. See
the sections below to see how to send Beams from various Pocket PC applications.

Using Pocket Internet Explorer

Without connecting to the Internet, you can use Pocket Internet Explorer to browse mobile favorites and
channels that have been downloaded to your PiN. You can also connect to the Internet through an ISP or a
network connection and browse the Web.

W|internet Explorn &t o€ 4118 €3

filee: {windows\default. it ~| &

V. N Microsoft

Pocket Internet Explorer
welcome to Pocket Intermet.
Explorer. Mot online yet? Find out
how to get connected and save
offine content.
Carrier
OEM

PocketPC.com

view Tools ¢ %) ¢ % z‘.

Faworites button.
Home hutton
Refresh buttan

To view mobile favorites and channels:

1. Tap the Favorites button to display your list of favorites.
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Internet Explorer  &F o 6:55 @

Favorites

£ Mohile Favorites
o MSN Mohile ]
[@ Pocket PC web Guide —— e e favirite you
¥} Packet PC.com
& windowsMedia.corn
|2 Restaurants

Open | &dd | Delete | —————————Tap to add or delete
a falder or favarite link.
E|‘

2. Tap the page you want to view.
You will see the page that was downloaded the last time you synchronized with your desktop computer. If
the page is not on your PiN, the favorite will be dimmed. You will need to synchronize with your desktop
computer again to download the page to your PiN, or connect to the Internet to view the page.
To browse the Internet:
1. Set up a connection to your ISP or corporate network using Connections, as described in Chapter 16.
2. To connect and start browsing, do one of the following:

. Tap the Favorites button, and then tap the favorite you want to view.

. Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter

the Web address you want to visit and then tap on the green arrow icon.

Maintaining Favorites
Aside from Mobile Favorites created by an ActiveSync profile, you can create favorites of Internet websites.

1. Browse to a website using the above instructions.

Favorites

Select an item to delete:

[+ Mabile Favorites

¥ MEN Mobile

i Pocket PC webh Guide
() Pocket PC.com

{5 windawshMedia.com
L8] &nimated Gif Samples

| Add... || Delete ||New Folder|
Open | Add | Delete
Vas

2. You can create a new folder of favorites by pressing New Folder.
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New Folder
Mame:
Fur websited |
| Add || Cancel |
Vas

Enter the name and press Add.

3. Open the File Explorer Add/Delete tab in Favorites. Press the Add... button.

Add Favorite

Mame:

|Animated Gif Samples |
Address (URL):

|http:,l’,l’www.webextra.com,l’animatedgif |

Create in:

Add | | Cancel |

Vs

Either accept the suggested favorite name or enter your own. The associated URL will be displayed
below the favorite name. Highlight an appropriate folder in Create in: and press Add.

Working with Webpages

By default, webpages will appear with images loaded. Let us visit a website to see how various options
affect rendering of pages.
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7% |Internet Explorer * . =< 10:55 °
http: foewew microsoft .comwindow « @

mmms Moabile

Windows Mobile Horne

Products

| Packet pc |
Pocket PC Phone Edition

h

[l ] I I

View Tools < @ faf t&g @ E|A

During loading, a spinning icon will appear in the upper right-hand corner. Tap e to halt page loading.

Once loading has completed, tap to reload the page or ¢ to visit the last loaded page.

+ Fit ko Screen

v Show Images

v Address Bar
Text Size 3

History
Properties

Yiew|Tools @ @

The View menu allows you to move forward to the next page (if ¢ was just pressed), Fit to Screen (minimize
horizontal scrolling by shrinking table width and image sizes), Show Images (or conversely Hide Images),
Address Bar make visible, and change text size.

nternet Explorer ¢ =% 10:55 e

bty favwewe icrosoft .comfwindow. « @

Windaws
Mobile

Windaws Mobile Home

Products

| Pocket pc |
Packet PC Phone Edition

[l ] I [l

Yiew Tools Q o % @ E|‘

When the above website is loaded but with images hidden, image placeholders appear.
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j‘ Internet Explorer ¢F (£ 10:55 °

http: foewew microsoft .comwindow « @
- B

Select All Text
Refresh Page
Add to Favorites
Show Picture

Windows Mobile Horne
Products

| Packet pc |
Pocket PC Phone Edition

[l ] | I

View Tools < @ faf t&g @ E|A

mmowsnﬂobile =

Windoves Mobile

Windaws Mobile Home

Products

| Pocket pc |
Packet PC Phone Edition

[l ] I [l

Yiew Tools @ o % @ E|‘

Now that image is revealed.

NOTE: It is a good idea to turn off images when connected over a wireless Internet connection, where
you pay for each megabyte transferred. Large images can be expensive to download!

Forward

+ Fit ko Screen
v Show Images
v Address Bar

Largest

- Larger
History * Medium
Properties smaller
view|Tools & 4 Smallest

Text size can be changed from largest to smallest, as in desktop Internet Explorer.
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nternet Explorer 4F (£

History

Page Title ~

MSDN Home Page
Microsoft Corporation
Untitled

=18

View—History gives you single-click access to recently visited websites. You can view history by page title.

nternet Explorer

History

Address (URL) ~

http/ frnsdin.microsoft.com)
http:f fueswene microsoft.com,?
hittpf feewes microsoft.comfwindows., .,

Alternatively, you can view history by URL.

nternet Explorer

Properties

@ M5O Home Page

Protocol: HyperTexk Transfer Protacol

Type: HTML Document
Size: Z8.4 KB (29127 bytes)
Encryphion:  Mone

Address (URL): |hkkp: ffmsdn.microsaft.comy

E|‘

Lastly, a webpage’s properties can be viewed by View—Properties. Here we can see protocol used,
document type, size of document, security settings, and URL. In addition to strict HTML, Pocket Internet
Explorer may be used to open common image files, WAP websites, and WML files.

When leaving a site using SSL to a public website, you will be reminded of this change in security level.
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Configuring PIE

PIE gives you basic control over how webpages appear and how saved temporary Internet files are
maintained.

Home page
about:hame
| Use Current | | Use Default

History

Save links to pages visited in the past
!: dayis) Clear History

Temporary Internet files

‘Web content that has been previously
viewed or synchronized with the device,

Delete Files

General | Advanced |

Vs

In Tools—Options you can change the default home page by using the currently loaded page or the PiN
default. Next, you can choose the size of history saved in days. Press Clear History to remove past history
information. Delete Files will remove temporary cached files (such as webpages and images) to free space
on your PiN.

Cookies
Allow cookies Clear Cookies

Security settings

‘Warn when changing to a page
that is not secure

Language

Default character set

‘Western European -

General | Advanced |

Vs

Advanced options allow you to turn off cookies, clear cookies, warn when changing to an insecure page, and
change the default character set.

NOTE: Some websites may not render properly if cookies have been disabled.
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17. Troubleshooting

This chapter suggests possible solutions to common problems with your PiN. If you cannot find the answer
to your question here, or if the recommended solution does not solve your problem, please contact your
retailer for assistance or visit the Navman support website for your area (see Support Information, page 116).

Troubleshooting

Problem

Possible Cause

Recommended Solution

Operation Frozen

1.1 | PiN softwareis | Software error Restart your PiN by doing a ‘Soft Reset.” The PiN remembers
“locked up” your settings, and returns you to the Pocket PC desktop. Your
and will not saved data will be retained by your PiN. Resetting your PiN is
respond. similar to shutting down and restarting your desktop computer.

Any unsaved data will be lost.

1.2 | lcan't User sets Restart your PiN using a Hard Reset. This completely resets
remember my password and your PiN to its original factory settings. It removes all RAM data
password then forgets it. from your PiN and requires you to set up your PiN again as if

using it for the first time. To ensure the integrity of your data
you should carry out regular backups. Resetting your PiN is
similar to shutting down and restarting your desktop computer.
Any unsaved data will be lost.

1.3 | PiN software Software error Restart your PiN using a Hard Reset. This completely resets
still “locked your PiN to its original factory settings. It removes all RAM data
up” following from your PiN and requires you to set up your PiN again as if
soft reset. using it for the first time. To ensure the integrity of your data

you should carry out regular backups. Resetting your PiN is
similar to shutting down and restarting your desktop computer.
Any unsaved data will be lost.

2 Power Problems

2.1 | lcan’tturn on The battery has Connect the PiN to a power source, then try to activate it.
my PiN while too little charge NOTE: If the battery completely runs out of power and is not
using battery to operate your charged in time, your PIN may act as if you have carried out a
power PiN Hard Reset next time you activate it.

2.2 | MyPiN runs Battery not fully When not in use, keep the PIN connected to a power source.
out of power charged This will ensure that the battery is always charged.
quickly.

2.3 | My PiN runs Too many Close open applications that you are not using and continue to
very slowly applications work.

open

2.4 | MyPiN runs Battery low Connect the PiN to a power source. You can continue to work

very slowly while it charges.
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3 Memory Problems

3.1 My PiN tells me it PiN memory full Deletany applications that you no longer need.
has insufficient Tap .’ -> Settings > System tab > Remove
memory. Programs. Tap the program you want to remove and

then tap Remove.

3.2 | My PiN tells me it PiIN Memory full Delete files that are no longer required. Always be careful
has insufficient when deleting files. Do not delete files whose purpose is
memory and | unknown as this may impact the software. It is
can’t delete any reoommendedthat you create backups before deleting
programs any files. Tap &8 - Programs - File Explorer. Tap and

hold the file you wish to delete and then tap Iete onthe
pop-up menu. To find your largest files, tap - Find.
In the Type list, tap Larger than 64KB > Go

3.3 | My PiN tells me it PiN Memory full . Delete all files and clear history from Internet
has insufficient Explorer. In Internet Explorer, tap Tools >
memory and | Options. Tap Delete Files and Clear
can’t delete any History.
more files or
programs . Move email attachments to the memory card.

In Inbox, tap Tools - Options - Storage
tab and check Store attachments on
storage card. All attachments are moved to
the memory card and new attachments are
automatically stored on the memory card.

. If the memory card is full, and all data stored
thereon is required, it is possible to purchase
extra and/or larger memory cards.

4 Screen Problems

4.1 | Screen does not Low battery Connect the PiN to a power source, then try to activate it.
activate when |
turn on my PiN

4.2 | Screen does not Software error Restart your PiN by doing a ‘Soft Reset.” The PiN
respond when remembers your settings, and returns you to the Pocket
battery is charged. PC desktop. Your saved data will be retained by your PiN.

Resetting your PiN is similar to shutting down and
restarting your desktop computer. Any unsaved data will
be lost

4.3 | The screenis Software error Restart your PiN by doing a ‘Soft Reset.” The PiN
frozen remembers your settings, and returns you to the Pocket

PC desktop. Your saved data will be retained by your PiN.
Resetting your PiN is similar to shutting down and
restarting your desktop computer. Any unsaved data will
be lost

4.4 | Screen is hard to Backlight Turn on the backlight
read deactivated

4.5 | Screenis hard to User is in a poorly | Move to a location with better light
read and backlight | lit location
is activated

4.6 | Screenis hard to Fonts unclear Activate ClearType. This smooths the edges of screen

read and backlight
is activated

fonts for many programs.

Tap .’ - Settings > System tab > Screen icon.
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Check the Enable ClearType check box.

4.7 | Writing on screen User requires Increase the size of the text on screen.
is too small larger text in
order to read . In Notes, tap Tools and select a zoom
clearly percentage.
. In Pocket Word and Pocket Excel, tap View
- Zoom and select a zoom percentage.
. In Pocket Internet Explorer, tap View - Text
Size and select a size.
. In Calendar, Contacts and Tasks, tap Tools
- Options and select Use large font.

4.8 | Keys on electronic User requires Incree the size of the keys on the keyboard.
keyboard too larger text in Tap [‘.’ - Settings = Personal tab - Input icon.
small order {0 read Select the Large Keys check box

clearly 9 4 '

4.9 | My PiN doesn’t $oreen Tap - Settings > System tab > Screen icon.
respond incorrectly ) . S .
accurately to aligned Click Align Screen and follow the PiN’s instructions. If you

cannot correctly tap your selection, you can Hard Reset
stylus taps ;
the PiN

5 Computer Synchronization Problems

51 My PiN cannot Incorrect version Load the version of ActiveSync provided with your PiN
synchronize with of ActiveSync onto your computer.
my computer. installed on

computer

5.2 | My PiN cannot USB Cable not Ensure that the USB cable between your computer and
synchronize with properly your PiN is securely connected to both machines. Do not
my computer connected run the USB cable via a USB hub.

5.3 | My PiN cannot Connection not Ensure that both the PiIN and the computer are turned on
synchronize with being recognized before establishing the connection.
my computer

5.4 | My PiN cannot USB Connection Make sure that the USB connection is enabled in
synchronize with enabling problem ActiveSync on your desktop computer. If the USB
my computer connection is already enabled, disable the USB

connection, close the Connection Settings window and
then reopen and re-enable the USB connection.

5.5 | My PiN cannot USB Connection Soft Reset your PiN before connecting the USB cable.
synchronize with enabling problem Always disconnect your PiN before you restart your
my computer computer.

5.6 | My PiN cannot Multiple Pocket Connect only one Pocket PC or PDA to your computer at
synchronize with PC/PDA a time.
my computer connections

5.7 | My PiN cannot Too many active Make sure that you do not have any other active
synchronize with connections connections.
my computer Tap ir’ and tap Today. Tap L] or g at the bottom of

the screen and then tap Disconnect.

6 Infra-Red (IR) Transfer Problems
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6.1 | cannot transfer Trying to transfer Transfer only one file, or no more than 25 contact cards,
data using an too much data at a time.
infrared
connection

6.2 | Infrared IR ports not Position the IR ports so that they line up in a distance less
connection not aligned than 20 cm (8 inches) but more than 5 cm (2 inches)
recognized apart. Ensure that there are no physical obstacles

between the IR ports.

6.3 | Infrared Lighting Some types of light interfere with IR communications. Try
connection not interference moving to a different location or turning off some lights.
recognized

7 Network Synchronization Problems

71 | cannot connect Network card Make sure that your network card is compatible with your
to my network incompatibility PN

7.2 | | cannot connect Drivers not Make sure that you have installed the proper drivers for
to my network installed your PiN

7.3 | I cannot connect Network card In the properties for your network card, make sure that
to my network properties you have correctly configured the IP settings, and the

incorrectly set addresses of your DNS servers and/or WINS servers.
Your network administrator can verify this
7.4 | | cannot connect Server Make sure that you have added necessary server
to my network mforrgagon not information. Tap [‘I > Settings > Connections tab >
provice Connections > Advanced tab - Network Card. Select
the installed network card (usually the card’s name) and
enter any necessary information. Most networks use
DHCP to assign IP addresses dynamically; you should not
have to change or enter any IP address settings unless
your network administrator instructs you to do so

7.5 | | cannot connect Incorrect user Verify with your network administrator that your user name

to my network name or and password are correct.
password

7.6 | I cannot connect Network Verify with your network administrator that the network is
to my network unavailable available and you are authorized to connect to it.

7.7 | I cannot connect PIN of the same Change your PiN’s PiN name. Tap > Settings >
to my network name already System tab = About = PiN ID tab

connected ystem tal ou i ab.

7.8 | I cannot Network If Network Connection is not listed as a connection
synchronize connection not method in the ActiveSync dialog box when starting
across my present in Active synchronization, wait a few minutes and try again. Also, if
network Sync synchronization does not start right away, the network is

probably busy, and it may take a minute for your Pocket
PC to connect to the network.
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18. Regulatory Information

Regulations Statements

Class B Regulations

c Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE

USA
Federal Communications Commission Radio Frequency Interference Statement

NOTE:

This equipment has been tested and found to comply with the limits for a Class B digital PiN pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of
the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
. Consult the dealer or an experienced radio/TV technician for help.

Any changes or modifications not expressly approved by the manufacturer could void the user’s authority to
operate the equipment.

Please note:

The use of a non-shielded interface cable with this equipment is prohibited.

Canada
Canadian Department Of Communications
Radio Interference Regulations Class B Compliance Notice

This Class B digital apparatus meets all requirements of the Canada Interference-Causing equipment
regulations.

Cet appareil numérique de Classe B respecte toutes les exigences du Reglement Canadien sur le matériel
brouileur.

Operation is subject to the following two conditions: (1) this PIN may not cause interference, and (2) this PIN
must accept any interference, including interference that may cause undesired operation of the PiN."
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Standards Compliance

. Europe (CE)

o Complies with Radio & Telecommunication Terminal Equipment Directive (RTTE)
. e-mark

0  95/54/EC Automotive EMC Directive
° C-tick

0o Radio Communications (EMC Standards) Notice 2004 EN 55022 (IT Equipment) Radiated &
Conducted Emissions

Safety Precautions
Charging
. Use only the AC adapter supplied with your PiN; use of another type of AC adapter will result in
malfunction and/or danger.
. Use only the car charger supplied with your PiN; use of another type of car charger will result in

malfunction and/or danger.

AC Adapter

. Do not use the adapter in a high moisture environment. Never touch the adapter when your hands or
feet are wet.

. Allow adequate ventilation around the adapter when using it to operate the PiN or charge the battery.
Do not cover the AC adapter with paper or other objects that will reduce cooling. Do not use the AC
adapter while it is inside a carrying case.

. Connect the adapter to a proper power source. The voltage and grounding requirements are found on
the product case and/or packaging.

. Do not use the adapter if the cord becomes damaged.

. Do not attempt to service the unit. There are no serviceable parts inside. Replace the unit if it is
damaged or exposed to excess moisture.
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Battery

Please read and follow the handling instructions for the battery before use. Improper use of the battery may
cause heat, fire, explosion, damage or capacity deterioration of the battery. However, the manufacturer will
not guarantee against any accident caused by the usage which is not written here.

DANGER

. Do not dip or wet the battery in water, seawater, or other liquid. If the protecting pin assembled in the
battery is damaged, the battery may be charged with an abnormal current and voltage, which may
result in the cause of heat generation, explosion, or fire of the battery.

. The battery has a predetermined polarity. If the battery will not connect well to the charger or
equipment, do not try to connect the battery forcefully. Check the polarity first. In the case the battery is
connected in reverse, it is charged reversely and may cause acid leakage, heat generation, explosion,
or fire due to an abnormal chemical reaction.

. Do not put the battery into a fire or heat it. In such a case, the insulator in the battery may be melted,
the safety vent and structure may be damaged, all of which may cause heat generation, explosion, or
fire.

. Do not connect the battery reversed in positive (+) and negative (-) terminals in the charger or
equipment. In the case the battery is connected in reverse, it is charged reversely during charge, and
causes an excessive current during discharge, and may cause heat generation, explosion, or fire due to
an abnormal chemical reaction.

o Do not let the battery terminals ( + and - ) contact a wire or any metal ( like a metal necklace or a
hairpin ) with which it carried or stored together. In such a case, the battery is shorted and causes an
excessive current, which may result in heat generation, explosion, or fire.

. Do not apply heavy impact to the battery, or throw or drop it. Strong impact may damage the
protecting pin, which may result in heat generation, explosion, or fire of the battery.

. Do not drive a nail in, hit with a hammer, or stamp on the battery. In such a case, the battery may be
deformed and shorted, and the protecting pin may be damaged, which may cause heat generation,
explosion, or fire of the battery.

. Do not solder the battery directly. Heat applied during soldering may damage the insulator or the safety
vent and mechanism, which may result in acid leakage, heat generation, explosion, or fire of the
battery.

. Do not disassemble or alter the battery. The battery contains a safety mechanism and a protecting pin
in order to avoid any danger. If these are damaged, heat, explosion or fire may be caused.

. Charge the battery every 6 months to the amount specified by the manufacturer, even if the battery is
not used. An excessive over-discharge may cause an abnormal chemical reaction, which may result in
the cause of acid leakage, or fire of the battery.

About the Infrared LED

The IR port located on the Pocket PC is evaluated as a Class 1 LED (Light-Emitting Diode) device according
to International Standard IEC 60 825-1 (EN60825-1) requirements.

CLASS 1 LED PRODUCT
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Support Information

Support for
Australia:

Navman Australia Pty. Ltd

PO Box 479

Gladesville

NSW 2111

Australia
pcnsupport.aus@navman.com
Www.navman.com

Support for
New Zealand:

Navman NZ Ltd.

PO Box 68-155

Newton

Auckland

New Zealand
pcnsupport.nz@navman.com
Www.navman.com

Support for
Europe:

Navman Europe Limited

4G Gatwick House

Peeks Brook Lane

Horley, Surrey RH6 9ST
United Kingdom
support@navman-europe.com
WWW.navman-europe.com

Support for the
US and Canada:

Navman USA Limited
27142 Burbank

Foothill Ranch, CA 92610
United States of America
Phone: 866-9-NAVMAN
support@navmanusa.com
WWW.navmanusa.com

Compliance

This PiN complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This
PiN may not cause harmful interference, and (2) this PIN must accept any interference received, including
interference that may cause undesired operation.

NAVMAN DISCLAIM ALL LIABILITY FOR ANY USE OF THIS PRODUCT IN A WAY
THAT MAY CAUSE ACCIDENTS, DAMAGE OR VIOLATE THE LAW.
Copyright

© 2005 Navman NZ Limited. Navman is a registered trademark of Navman NZ Limited. All rights reserved.
Microsoft Windows 98 SE, ME, 2000 or XP SP1, Intermnet Explorer, ActiveSync are registered trademarks of
Microsoft Corporation. All rights reserved.

Microsoft Passport and Windows Mobile are trademarks of Microsoft Corporation. All rights reserved.
SmartST is a trademark of Navman NZ Limited. All rights reserved.

Acer is a registered trademark of Acer Inc. All rights reserved.

Adobe Reader is a registered trademark of Adobe Systems Incorporated. All rights reserved.

Jot is a registered trademark of Communications Intelligence Corporation. All rights reserved.

Graffiti is a registered trademark of palmOne, Inc. All rights reserved.

All other trademarks and registrations are the property of their respective owners.

Published in New Zealand.
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